# Table of Contents

**Part I**  Introduction  

**Part II**  How to Read this Document  

**Part III**  Important Notice  

**Part IV**  Overview  

1. General Product Information ................................................................. 8  
   - Product Variants .................................................................................. 8  
   - Dongle Protection and License Update ............................................... 9  

2. Features and Benefits .............................................................................. 12  

3. Basic Operation ...................................................................................... 15  

4. System Setup .......................................................................................... 16  

**Part V**  Configuration  

1. Global Settings ....................................................................................... 19  

2. Network Settings .................................................................................... 22  

3. Double PC Setup ..................................................................................... 23  

4. Double Monitor Settings ......................................................................... 26  

5. RED Standalone Setup ........................................................................... 28  

**Part VI**  Step-by-step Instructions  

© 2010 SensoMotoric Instruments GmbH
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Step-by-step: Overview</td>
<td>32</td>
</tr>
<tr>
<td>2</td>
<td>Starting Experiment Center</td>
<td>33</td>
</tr>
<tr>
<td>3</td>
<td>Preparing Experiments</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Creating a New Experiment</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Loading and Changing an Experiment</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Saving Experiments</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Delete Experiments</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Import/Export Experiments and Results</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Stimuli Settings</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>Calibration</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Validation</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Text Stimulus Element</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Questionnaire Element</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>Image Stimulus Element</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Web Stimulus Element</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>Movie Stimulus Element</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Screen Recording Stimulus Element</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>External Video Source Element</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>Randomization - Groups and Duration</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Subject Properties</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Annotations</td>
<td>80</td>
</tr>
<tr>
<td>4</td>
<td>Running Experiments</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Dry Running an Experiment</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Running an Experiment</td>
<td>85</td>
</tr>
<tr>
<td></td>
<td>RED subject placement</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>Starting New Subject</td>
<td>88</td>
</tr>
<tr>
<td></td>
<td>Running Calibration</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Stimuli Presentation</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Create Annotations</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Ending Recording</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Subject Protocol</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Analyzing Experiment Data</td>
<td>97</td>
</tr>
</tbody>
</table>

Part VII  User Interface  99
1 Application Window ................................................................................ 99
2 Toolbars .............................................................................................. 101
3 Menu Commands .................................................................................. 104
4 Keys Overview ..................................................................................... 107
5 Text Editor Window ............................................................................. 109

Part VIII Data Storage ........................................................................ 112
1 Data Storage Structure ....................................................................... 112
   Directory Structure ............................................................................. 113
   Importing and Exporting Experiments ............................................. 114
2 Experiment Files .................................................................................. 115
3 Results Files ....................................................................................... 116
4 Supported File Formats ..................................................................... 118

Part IX Appendix .................................................................................. 121
1 Limitations / Setup recommendations ............................................. 121
2 Dongle Installation and Troubleshooting ....................................... 122
3 Installation and Setup of External Video ....................................... 124
   Frame Grabber Driver Setup ........................................................... 125
   Hardware Setup ............................................................................... 127
   VGA Setup ...................................................................................... 128
   HDMI Setup ................................................................................... 141
4 Information on Calibration ............................................................... 154

© 2010 SensoMotoric Instruments GmbH
Contents

5 Information on User camera and Audio Recording.. 155
6 Program Installation.................................................. 156
7 System Requirements................................................... 157
8 Network Sharing Solver Tool........................................ 160
9 Troubleshooting........................................................... 162
10 Turn off Hardware acceleration..................................... 165

Part X Copyright and Trademarks 168
Part XI License Agreement and Warranty 170
Part XII About SMI 177

Index 178
1 Introduction

Congratulations on your purchase of SMI Experiment Center™ 2.4, a software designed to make gaze tracking experiments and visual stimuli creation a snap. SMI Experiment Center™ 2.4 and the accompanying SMI iView X™ system and the SMI BeGaze™ 2.4 software are designed particularly for researchers working in the fields of reading research, psychology, neurology, cognitive neuroscience, marketing research and usability testing.

SMI Experiment Center™ 2.4, the SMI iView X™ system and the SMI BeGaze™ 2.4 software build up a powerful platform to record and analyze gaze tracking data. This platform supports a broad range of studies ranging from usability testing and market research to psychology and physiological experiments. This platform is ideal for evaluating interactive media such as web sites, software along with print and online advertising.

Document number: 091222-P-1399-001-000-A
How to Read this Document
2 How to Read this Document

This manual is designed to serve both as online help and as printed documentation of Experiment Center.

The software version covered in this document is: 2.4

You can use this manual in one of these ways:

- Read through the chapters pertaining to particular functions to get background information before using the program.

- Consult the manual as a reference document to find out particular information. You can find a topic either by consulting the table of contents (at the front of the manual), or the index (at the end).

All the information in this manual can also be accessed through the program. Press [F1] to open the Online Help on a menu item or on the element that has currently the input focus or that is selected.

It is probably not necessary to read all the chapters consecutively as there was an effort to make every chapter complete within itself. This means that some phrases may recur. You may leaf through the chapters to look for the topics that interest you. The link references included in the text as well as the table of contents and the index should help you find your way through this document.

You can locate information fast by using the Online Help’s table of contents, index or full text search features.
Important Notice
3 Important Notice

Experiment Responsibility

Make sure the presented visual stimuli do not harm or injure your subjects. SensoMotoric Instruments GmbH is in no way responsible for the experiments you develop, execute, and analyze. Do not offend against your subject's cultural background, age, psychological condition, or similar.

Photosensitive Epilepsy

Some people may have epileptic seizures triggered by light flashes or patterns. This may occur while presenting successive pictures or video material, even if they have never had a seizure before.

Supervise your subjects during experiments. Stop immediately and consult a doctor if a subject has the following or similar symptoms:

- Involuntary movements
- Disorientation
- Convulsions
- Loss of awareness
- Altered vision
Overview

Chapter IV
4 Overview

4.1 General Product Information

4.1.1 Product Variants

SMI Experiment Center™ 2.4 is available in the following **product variants**

- **Experiment Center 2 Light**
  full featured without screen recording

- **Experiment Center 2 Professional**
  full featured including screen recording

- **additional Reading Package**
  automatic AOI generation for reading experiments

- **additional Observation Package**
  adds user video and user audio recording

- **additional External Video Package**
  adds possibility to connect external video sources such as Playstation, XBox, TV

⚠️ Each brand named in this manual is industrial property of its manufacturer.
4.1.2 Dongle Protection and License Update

Experiment Center is dongle-protected and requires a license. If you want to update your Experiment Center version, please contact the SMI sales department to obtain a new license.

Collect license information

The SMI sales department will need your current license information:

1. From the Windows™ start menu, select Programs: SMI: Experiment Suite 360° Remote Update Utility.

2. In the Collect Key Status Information tab of the Remote Update Utility, click the Collect information button. This will acquire the current license information which is currently stored on the dongle device.

3. You will be prompted to save a file identifying your current Experiment Center license (“Save key status”). Please save the file under your last
name for easy identification.

4. Send this file to sales@smi.de.

You will receive a new license key from SMI.

**Update license**

After you have purchased your new license key (*.v2c file format), update your license as follows:

1. From the Windows™ start menu, select Programs: SMI: Experiment Suite 360° Remote Update Utility.

2. Switch to the Apply License Update tab.

![HASP_SRM_RUS](image)

Ensure that only the Experiment Center dongle is plugged. Remove all other dongles from the PC.

3. Locate the update file (*.v2c) by clicking on the browse button and click **Apply Update**. This will write the updated license information to the dongle device.

4. You will be prompted that a receipt has been produced to confirm the
update. Please send this receipt file to support@smi.de.

5. Close the Remote Update Utility and start Experiment Center.

Type and status of your licenses are stored on the dongle device, not on the PC on which Experiment Center is installed. With the license update procedure, the dongle is updated. That means, that you can run Experiment Center on any PC when the dongle is plugged in.
4.2 Features and Benefits

Applications
SMI Experiment Center™ 2.4 is optimized for certain applications, e.g.

- Psychological experiments based on videos and/or pictures (grouped, randomized, dwell time trigger AOI)
- Market Research analyzing advertisements (TV Spots, printed advertisements ...)
- Reading Studies with automatic AOI generation for words, sentences and paragraphs
- Website analysis of full length web sites with scroll compensation, recording of user events (mouse clicks, key presses) and background screen recording
- Software usability with screen recording, including gaze position, mouse cursor and user event overlays
- Game and TV analysis using external video sources

Features and Benefits
SMI Experiment Center™ 2.4 is an easy to operate experiment creation, planning and experiment execution environment. It is complemented by SMI iView X™ for gaze tracking data acquisition and SMI BeGaze™ 2.4 for gaze tracking data analysis.

Experiment Center delivers experiment design and experiment control in a user-friendly design, which enables you to handle the Experiment Center functionality out of the box. Experiment Center allows you to prepare and execute gaze tracking experiments with the following features:

- A single user interface for managing various functions, including stimulus preview, live gaze monitoring, and precision timing
- Online guide for optimal subject placement in front of the remote eye
tracker

- Integrated calibration and validation including support for animated calibration targets and immediate validation of calibration quality

- Calibration and Validation on demand

- Text, images, video, full length web sites, or interactive programs with screen recording or external video sources can be displayed to each subject step by step while the subject's gaze position is monitored and gaze tracking data is recorded

- Questionnaire module for multiple-choice and free text questionnaires

- Integrated User (Webcam) and Audio recording (requires observation package license)

- A randomization/scrambling group function to allow groups of stimuli to be presented in a non-determined order and randomization of presentation time

- A lock/unlock function to prevent accidental invalidation of experiments already used in a recording

- All visual stimuli can be displayed for 500 milliseconds or longer while maintaining a high timer accuracy

- A dry run function for test scenario evaluation – without calibration and recording

- An integrated data storage to allow the acquired data to be analyzed in the BeGaze 2.4 software

- Presenting the next stimulus can also be triggered by looking into a predefined area of the subject ("AOI dwell time trigger")

- Annotations for user behaviour coding

- TTL Trigger on LPT1 port.

Experiment Center runs on a standard PC and connects to the iView X system. The iView X system in turn operates an attached gaze tracking
device. Currently supported eye tracking interfaces are

- RED4
- RED (60, 120 Hz)
- RED250 (60, 120, 250Hz)
- Hi-Speed 500Hz, 1250Hz
- fMRI-LR, fMRI-SV, and the MEG gaze tracking systems.

You can run Experiment Center directly on the iView X system. Alternatively, Experiment Center runs on a dedicated stimulus PC which is connected to the iView X system using a network link.

Double monitor operation is also supported. You can present visual stimuli on one monitor while doing experiment control on a second monitor.
4.3 Basic Operation

Experiment Center is optimized for a typical gaze tracking experiment workflow:

- During experiment design time, you start the Experiment Center software and create the "storyboard" for the visual stimuli to present. You have to lock the experiment to prevent changes during experiment execution. For test purposes you can check the stimuli combination with the dry run function until it is sufficient for your needs. You then save the results to an experiment.

- The necessary data storage is automatically created by Experiment Center. Therefore you simply enter an experiment name. With this experiment name a subdirectory will be created which contains similar named experiment files.

- During experiment execution time, you start Experiment Center which automatically connects to the iView X eye tracker. You load the created experiment and present the prepared stimuli to your subjects one by one. Experiment Center now records the subject’s eye movements while he or she is viewing at or interacting with the presented stimuli. While recording, Experiment Center automatically stores the eye and gaze tracking data and the corresponding stimuli files to an experiment results directory for later analysis.

A typical gaze tracking experiment involves persons with two different roles: an operator who controls the experiment and a subject whose gaze position and actions are monitored. The operator starts the experiment, enters information for each subject (e.g. the subjects name), and verifies the calibration necessary to adapt the iView X eye tracking software to the subject's eye characteristics.
4.4 System Setup

For eye and gaze tracking experiments with Experiment Center, two different system setups are possible:

- With a single PC setup, one iView X system runs the iView X gaze tracking system as well as Experiment Center. Both components are interconnected using a PC-internal socket connection. This is the recommended standard configuration depicted below.

- With a double PC setup, the iView X gaze tracking system is executed on one PC. This PC is connected to the gaze tracking device which is for example an RED4 interface mounted underneath the visual stimulus monitor. Experiment Center is executed on a second PC. Both components are interconnected using a UDP/IP socket connection (see Global Settings). This setup can be used for example if dedicated performance requirements exist and the CPU usage of the iView X system disturbs the visual presentation or subject interaction.

While it is possible to execute experiments using a single monitor, the standard experiment setup includes a double monitor setup: one monitor for the operator and a second monitor to present the visual stimuli to the
subject (see Double Monitor Settings). Please read also the chapter Limitations / Setup recommendations.
Chapter V

Configuration
5 Configuration

5.1 Global Settings

The Global Settings dialog allows you to change the Experiment Center configuration. If you simply want to reconnect Experiment Center to the iView X system, confirm the current settings with OK.

To change the Experiment Center default configuration depicted above proceed as follows:

1. In the Application Window, click . Alternatively, select the Extras: Global Settings menu command.

   The Global Settings dialog opens.
2. In the **Connections Settings** section, configure the network connection which is used to control and query the iView X system (see [Network Settings](#)). Click the **Reset** button to revert to the program defaults (localhost IP and port settings).

3. In the **Data Paths** section, configure the location where experiment related files are saved (see [Directory Structure](#)).

   The **Experiment Path** setting determines the storage location for experiment and stimulus data. For optimal results, the **Experiment Path** setting shall point to a local hard disk drive.

   The **Results Path** setting determines the storage location for of experiment results created while running an experiment. **For optimal results it is strongly recommended that the Results Path setting shall point to a local hard disk drive.**

   Activate **Enable Trigger on LPT1** to create a trigger signal on the LPT port each time a new stimulus starts. At the beginning of an experiment the status of the LPT port is 0. With each new stimulus the status of the LPT port is raised be 1.

   Activate **Record user camera** and select the connected webcam device from the **Video Source** selection. A preview window is showing the video of the currently selected webcam. The **config** button is opening the webcam specific settings dialog (please refer to user manual of the selected webcam).

   Activate **Record user sound** and select an audio input device from the **Audio Source** selection in order to add audio recording to the webcam video. Audio recording without video recording is not possible.

   **User camera and user audio recording requires the observation package license.**

4. Confirm your settings with **OK**.
When you've entered a foreign IP address of a remote iView X PC to configure a two-PC-setup you need to confirm that the result path is shared in the network. This is necessary in order to allow iView X to write the eye tracking data remotely into the results directory.

The changed settings are applied. If they do not exist, Experiment Center now creates the configured directories and also establishes the connection to the iView X system using the configured network settings.

It is not possible to change the directories while an experiment is open.
5.2 Network Settings

Experiment Center needs to be connected to the iView X system in order to control the gaze tracker and to acquire gaze tracking data. With a single PC setup, the iView X software is running on the same system. To establish a connection to the same host, the following default settings are used in Experiment Center:

- **Experiment Center Listening Port**: "5555"
- **iView X System (IP address)**: "localhost" or "127.0.0.1"
- **Port**: "4444"

For the iView X software, complementary settings are required. This means, that

- the listen port in iView X is the sending port of Experiment Center and
- the sending port in iView X is the listening port of Experiment Center.

The Global Settings dialog displays the IP address assigned to the PC running Experiment Center next to **Experiment Center (IPAddress)**. While you can configure this IP address in iView X, it is needed to use "127.0.0.1" or "localhost" if iView X is running on the same PC.

**Change Network Configuration**

In the iView X Hardware dialog, select "Ethernet" in one of the Remote Interface drop-down lists. Click the corresponding Configure button and copy the configuration depicted below.
5.3 Double PC Setup

It is possible to run Experiment Center and iView X on different PCs. In this configuration, the second PC, which runs iView X, must be able to write the eye tracking *.idf file to a shared folder which is located on the PC running Experiment Center.

The result path is automatically shared on the stimulus PC which need to be confirmed when you press the OK button in the Global Settings Dialog.

Change Network Configuration

With a double PC setup, the iView X software and Experiment Center run on different PCs. To establish a connection, change the IP address in both configuration dialogs:

- In the Experiment Center's Global Settings dialog, enter the IP address of the PC running the iView X software.
- In the iView X Network Configuration dialog, enter the IP address of the PC running Experiment Center. You may copy the IP address displayed in the Global Settings dialog next to Experiment Center (IP Address).

! It is automatically checked whether iView X is able to access to
Experiment Center by possessing the required rights. Please read the Network Sharing Solver chapter.

Unblocking the Firewall

Note that installed firewall products may block the communication. For example, you need to confirm the network connection with the pre-installed Windows personal firewall.

If you trust your local network environment, you can also disable the Windows personal firewall completely.

1. Right click the Network Environment icon located on the desktop or in the Windows Start menu. Select the Properties context menu entry.
2. In the Network Environment window, right click the Local Area Connection icon. Select the Properties context menu entry.

3. In the Local Area Connection properties dialog, navigate to the Advanced tab and click Settings.

4. In the Windows Firewall dialog, navigate to the General tab and select Off.

5. Confirm with OK.
5.4 Double Monitor Settings

To operate the double monitor setup, the corresponding system functions of the Windows operating system are used. Note that most note books provide an additional monitor plug for this. Otherwise you need a graphics adapter with double monitor (“dual head”) support.

The following steps activate the second monitor:

1. In the Windows Control Panel, select the Appearance and Themes category. With Windows XP, open the Display Properties applet and switch to the Display Settings tab. With Windows Vista, select the Change display resolution task.
2. Check whether the display driver supports a second monitor. This is the case if two screen icons ("1" and "2") are displayed. Check whether the second monitor is operational. This is true if the second monitor icon is not grayed out. Otherwise plug in and switch on the second monitor. You may need to re-open the **Display Properties** applet or – with some older notebooks – you may need to restart Windows.

3. Click on the second monitor icon and select the desired screen resolution. Confirm with **OK**.

In a standard setup, for example if you are the operator sitting in front of an notebook, you may use the second monitor to present the visual stimuli to your subject. To activate the second monitor as stimulus monitor:

1. Select the **Display2** entry in the **Select Stimulus Monitor** control of Experiment Center.

2. Click the **Identify** button (1 2) to verify the double monitor settings. The operator screen is identified by a large 1, while the subject should be placed in front of the monitor displaying a large 2 (Stimulus Monitor). The identify overlay disappears automatically after some seconds.

   **If you change the Windows monitor setup, you need to restart Experiment Center to update the Select Stimulus Monitor control.**
5.5 RED Standalone Setup

Experiment Center can be used to configure the RED stand-alone mode. Experiment Center needs an established connection to iView X and configures remotely the settings in iView X.

The corresponding profiles are stored and handled from iView X and are therefore system dependent.

Select from the menu Extras the submenu RED Operation Mode ....

Switch to Stand Alone and then select either an existing profile or press new to create a new one. The following dialog is shown.
The following steps are necessary to setup the RED in stand-alone mode:

1. Remove the RED from the monitor and mount it at the stand-alone foot.
2. Switch on your external screen (beamer, TV or monitor) and position it.
   The screen has to be planar.
   The screen has to be at right angle with the floor.
   The screen bottom line has to be parallel to the floor.
3. Enter a new profile name in the "Mode name" field.
4. Enter the geometric dimensions of your setup. You can let iView X suggest values according to the test person's placement. Therefore check Use Placement Suggestion. Select the distance between floor and the test person's eyes. The options are:
   - 80-110 cm: for test persons sitting comfortably on a couch or similar.
   - 110-140 cm: usual height for test persons sitting at a desk.
   - 140-180 cm: for test persons who are standing during the experiment.
4. Measure screen height, width and distance bottom line of screen to floor and enter the values.
5. Click on "Suggest RED Placement". The output of the software is a suggestion for
   - the distance RED to screen
   - the distance floor to RED
   - the RED inclination angle.
6. Place your RED according to the suggestions.
   RED is in the horizontal middle of the screen.
   The screen bottom line has to be parallel to the RED.
   Measure your chosen distance RED to screen and enter it.
   Adjust and measure angle of the RED according to the suggestions and enter it.
   Adjust and measure the distance RED to floor according to the suggestions and enter it.
7. Press OK.
8. To review if the profile fits, place a test person in front of the RED and check if the eyes are in the middle of the tracking monitor, if this is not the case, correct the distance RED to floor and the RED inclination angle and correct the parameters in the profile.
9. Test your experiment once and check if there is a stable tracking over the whole screen.
Step-by-step Instructions
6 Step-by-step Instructions

6.1 Step-by-step: Overview

In Experiment Center, you process the measurement data using the following steps:

1. Prepare the experiment: You can start with a new experiment or open an existing one and modify it. To modify an experiment, you have to unlock it.
   Preparation also consists of calibration and selection of the appropriate visual stimuli (such as text or images) which fits to the research objective. As an option, you may also add custom subject properties allowing you to characterize/group individual subjects during the experiment.

2. End preparation by locking the experiment.

3. Test the experiment design with a dry run.

4. Run experiment: If the dry run meets your requirements, start the experiment. The system will perform calibration and after that present the stimuli to the subject.
   The experiment and its results will be stored according to the defined directory structure.

5. Analyze the measurement data using the BeGaze 2.4 analysis software.

6. For database maintenance, you may delete unnecessary experiments later on.

The following topics in this help book provide step-by-step instructions to carry out these specific tasks with Experiment Center.
6.2 Starting Experiment Center

As a precondition, the iView X system needs to run in order to allow Experiment Center to auto-connect:

1. Double click the iView X icon on the desktop.

   ![iView X icon]

2. To start Experiment Center, use the Windows Start: All Programs: SMI: Experiment Suite 360°: Experiment Center 2.4 menu command. Alternatively, double click the following icon on the desktop.

   ![Experiment Center icon]

During startup, Experiment Center automatically tries to establish a connection to the iView X system. If that fails, Experiment Center tries to establish a connection with the settings from the last successful session.

3. Check the status of the connection by examining the connection button:

   ![Indicates established connection]
   Indicates that the connection is established. When the mouse cursor is over the icon, information is shown about the connected eye tracking device and iView X software version.

   ![Indicates not established connection]
   Indicates that the connection is currently not established.

As long as no connection is established, you cannot start a recording. If this is the case, check whether iView X is running and if the connection settings are correct (see Global Settings).
6.3 Preparing Experiments

6.3.1 Creating a New Experiment

An experiment is a set of visual stimuli that are presented in a sequential order to the subject.

**Create experiment**

To create a new experiment proceed as follows:

1. Double click the icon on the desktop.
   
   The Application Window opens. It is already disposed to create a new experiment. The calibration element is already included in the list of stimuli.

2. Add new stimuli and edit the stimuli’s properties.

3. Set calibration properties.

4. Optional: add subject properties.

5. When setting is completed, click to lock the experiment. This way settings cannot be changed accidentally.

6. Save the experiment (see Saving Experiments).

The currently logged in user information added the new experiment automatically. The creating user information only includes the username. This information helps you to identify experiments, for example if you reopen experiments later on or if you analyze the experiment using BeGaze 2.4.

**Execute experiment**

Start the experiment (see Running an Experiment) or test the settings with a dry run.
6.3.2  Loading and Changing an Experiment

In a typical gaze tracking experiment the stimulus presentation may be adapted to a modified research objective. You can create a new experiment for this, but it is also possible to modify an existing one.

**Load and change experiment**

To modify an existing experiment proceed as follows:

1. Click in the top toolbar.

The *Load experiment* dialog opens, presenting a list of existing experiments.

2. Select the desired experiment.
3. Click **Load**.

   The experiment is loaded into the Application Window.

4. Ensure that the experiment is unlocked. If it is locked, click to unlock.

5. Edit or modify experiment settings:

   Add new stimuli or change the stimuli settings. The order of stimuli can be changed as well (for more information see the help topic entitled Setting Stimuli).

   Change calibration properties.

6. Click to lock the experiment. This way settings cannot be changed accidentally.

7. Save the experiment (see Saving Experiments).

**Execute experiment**

Start the experiment (see Running an Experiment) or test the changed settings with a dry run.
6.3.3 Saving Experiments

To save an experiment proceed as follows. Note that you do not simply save an experiment file. Instead, Experiment Center uses the experiment name to create a subdirectory in the experiments directory which contains all used stimulus files and the experiment file (see Data Storage Structure).

1. Click ![folder icon] in the top toolbar. Alternatively, select the File: Save menu command or press the [CTRL] + [S] key combination.

   The Save experiment dialog opens presenting a list of existing experiments.

2. Enter a relevant experiment name and add a short experiment description in the input fields of this dialog. Do not use characters not valid for file names, such as “/”, “\”, “:”, “|”, or “<”. Use letters A-Z, digits 0-9, or the space character instead.

3. Click Save.

   ![info icon] Overwriting an existing experiment might invalidate already acquired eye tracking data.
Save experiment to a new name

1. Select Save as... from the File menu to save the experiment with a new name.

2. In the Save experiment dialog, enter the new name in the Name of Experiment field.

3. Add a short experiment description in the Description of Experiment input field.

4. Change the Created by information if desired. This information is inserted automatically when creating a new experiment.

5. Click Save.
6.3.4 Delete Experiments

Over time, the Experiment Center data base may include superfluous experiments. You can remove experiments with the following steps. Note that the corresponding sub-directory is removed from the Experiments folder (see Data Storage Structure).

1. From the File menu, select the Delete Experiments... command.

   The Delete Experiment dialog opens.

2. Select one or more experiments from the list. Press the [CTRL] key and select additional entries concurrently.

3. Click Delete.

   A query dialog opens, asking for confirmation. Click on Cancel to stop now. Click on Delete to confirm.
4. After the first confirmation, a second query dialog opens asking if you also want to remove previous recorded results from the hard disk.

Click **Delete** to remove the results. Click **Keep Results** if you do not want the results to be removed.

⚠️ You cannot revert the deletion of data after confirming one of the security queries. For this reason, you should make backups of your user data frequently.

### 6.3.5 Import/Export Experiments and Results

Please see [Import and Export of Experiment and Results](#).
6.3.6 Stimuli Settings

A stimulus is something that is presented on a monitor to the subject in front of the monitor. Experiment Center supports a broad range of stimuli types and allows combining them in one experiment. Each stimulus is represented as an element in the Application Window. While preparing the experiment, the operator can set the properties of each stimulus individually according to the experiment objective. The presentation can contain a validation, text, a question, an image, a web site, a movie, an interactive screen recording, or an external video.

Add stimulus

To add stimuli to be used in your experiment proceed as follows:

1. If the experiment is locked, click to unlock.
2. Click the desired button in the top toolbar. Alternatively, you can choose the respective entry from the Insert menu.

The stimulus is added to the list of stimuli as a new element.
3. Select one or more stimuli elements to set their properties.

**It is possible to change properties for multiple stimuli elements of the same type.**

The stimulus will be displayed in the preview window. The stimulus properties will be displayed in the properties window. Depending on the stimulus type, different properties are available.

4. Enter the desired values in the properties pane.

5. To undo any change, press [CTRL-Z]. Alternatively, you can choose the respective entry from the **File** menu. Similarly, to redo any change, press [CTRL-Y] or enter from the **File** menu.
### Delete stimulus

To remove stimuli not to be used in your experiment proceed as follows:

1. If the experiment is locked, click to unlock.
2. Select one or more stimuli in the list.
3. Press \[\text{DEL}\]. Alternatively, right click the desired stimulus entry and select the Delete Object command from the context menu.
4. To undo any change, press [CTRL-Z]. Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press [CTRL-Y] or enter from the File menu.

### Copy stimulus

To copy a stimulus in your current experiment please proceed as follows:

1. If the experiment is locked, click to unlock.
2. Select one stimulus in the list.
3. Press [CTRL-C]. Alternatively, right click the desired stimulus entry and select the Copy Element command from the context menu.
4. Select the position where you want to add the copied stimulus
5. Press \([CTRL-V]\). Alternatively, right click the desired stimulus entry and select the Paste command from the context menu.

6. To undo any change, press \([CTRL-Z]\). Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press \([CTRL-Y]\) or enter from the File menu.

**Change order of stimuli**

While you are designing an experiment, you may want to change the order of stimuli. To do so, proceed as follows:

1. If the experiment is locked, click \(\text{Unlock}\) to unlock.

2. Select an element with the mouse and drag it to the desired position in the list. While moving the mouse cursor, the currently focused list item is marked with a blue border.
   - If you move the mouse cursor up, the stimulus element will be placed previous to the blue marked list item.
   - If you move the mouse cursor down, the stimulus element will be placed after the blue marked list item.

3. To undo any change, press \([CTRL-Z]\). Alternatively, you can choose the respective entry from the File menu. Similarly, to redo any change, press \([CTRL-Y]\) or enter from the File menu.

4. To test the changed sequence, navigate through the list of stimuli using the cursor \([UP]/[DOWN]\) keys or navigate through the list using the arrow buttons below the preview pane:

   - Selects the previous stimulus
   - Selects the next stimulus
6.3.6.1 Calibration

Calibration is the adaptation to the current subject’s eye characteristics. During calibration, a number of targets in known screen locations are presented to the subject. The subject needs to fixate the presented targets while the position of the subject’s gaze is registered by the iView X system.

To get correct measurement results, it is vital to execute calibration before presenting your stimuli. Gaze tracking data acquired before calibration is completed successfully may be incorrect.

Insert a calibration

If you create a new experiment, the calibration is included as the first element in the list of stimuli by default. It is possible to move the calibration element to another position, for example to prepend a text message as subject information on the display.

You can also click in the list of stimuli.

Edit calibration settings

To edit the calibration settings proceed as follows:

1. Select the calibration element in the list of stimuli.
   The properties pane shows the current calibration settings. The preview pane displays the used target symbol.

2. **Background Color** field: Click on to open the color selection dialog, offering separate color tabs. Select the desired background color.
The selected color will also be used as frame color for all stimuli that do not fit to the full screen and if the stimulus is adjusted "transparent".

3. **Calibration method** field: The number of calibration points being used for the calibration can either be taken as a default directly as defined in iView X or can be directly selected (2/5/8/9/13 points). If the connected eye tracking device doesn’t support the selected calibration method then the best device specific default settings is being used instead.

4. **Target Animation** field: This field determines if the calibration target is animated. To change the animation mode, click 

   Select none for the default static target. Select blink for a target which is blinking twice. Select animated for a target which moves as an animation from point to point.

5. **Target Shape**
   a) **Target Shape** field: This field indicates the currently used target.

   To change the target, click 

   a list of target shapes: "black circle", "white circle", "black cross", "white cross". Select "user defined" to open the Select a file dialog. Navigate to the Experiment Center program directory and select the desired bitmap graphics file (BMP, JPG, PNG, ICO or animated GIF) to be used as calibration target. Click Open.

   **Caution**: Here, it may occur that you cannot select user defined targets twice. In this case you need to use the direct button "Target Shape".
b) **Target Shape** direct button in the preview window. Click on that button and select one of the four predefined targets or select a user defined target.

6. **Target Sound** field: A custom audio file (wav, mp3, wma) can be selected and is played back when the calibration target is presented to the subject. So the target sound should have an adequate length.

7. **Accept points automatically** field: If yes is selected (default), the calibration proceeds automatically after a stable fixation has been recognized for each target point. The first point requires always to press the space key to start the calibration process. If no is selected, each calibration point must be accepted manually by pressing the space key.

8. **Quality check** field: Click to open a drop-down list:
   - Select **Validation** (default) if a validation shall be executed at the end of the calibration routine, by showing four additional points to the subject. The validation quality is then presented visually and the average deviation of the subjects gaze to the validation points is shown. The operator can decide to continue or repeat the calibration if desired.
   - Select **Calibration** if the calibration quality shall be shown in a dialog box after the calibration. The calibration quality is presented visually and the average deviation of the users gaze during calibration in comparison to all calibration points is shown. The operator can decide to continue or repeat the calibration if desired.
   - Select **None** setting to continue with the next stimulus unconditionally.

9. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected
   - and continues playing when "CONTINUE" is selected in the next element
   - or stops when "STOP" or another file is selected in the next element
Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

After you have set the calibration continue with selecting and setting up the stimuli.

Direct Button

Direct Button "Target Shape" opens the target shape selection dialog. Please select one of the predefined calibration targets or an user defined target.

User defined targets can be static images (bmp, jpg, png) or animated targets (gif).

Direct Button "Calibrate Now" starts immediately a calibration (if Experiment Center is connected with iView X).
6.3.6.2 Validation

Insert a validation

To insert a validation click in the list of stimuli.

Edit validation settings

To edit the validation settings proceed as follows:

1. The properties window shows the current validation settings. The preview window displays the used target symbol.

2. Background Color field: Click on to open the color selection dialog, offering separate color tabs. Select the desired background color.

3. Target Animation field: This field determines if the validation target is animated. To change the animation mode click . Select none for the default static target. Select blink for a target which is blinking twice. Select animated for a target which moves as an animation from point to point.

4. Target Shape

   a) Target Shape field: This field indicates the currently used target. To change the target, click and select one of the following list entries from the drop-down list: “black circle”, “white circle”, “black cross”, “white cross”. Select "user defined" to open the Select a file dialog. Navigate to the Experiment Center program directory and select the desired bitmap graphics file (BMP, JPG, PNG, ICO or animated GIF) to be used as validation target. Click Open.

   ! Here, it may occur that you cannot select user defined targets twice. In this case you need to use the direct button "Target Shape".

   b) Target Shape direct button in the preview window. Click on that button and select one of the four predefined targets or select a user defined target.
5. **Target Sound** field: A custom audio file (wav, mp3, wma) can be selected and is played back when the validation target are presented to the subject.

6. **Accept points automatically** field: If yes is the selected (default), the validation proceeds automatically after the eye tracker has recognized a fixation. An exception is the first point, which always needs to be accepted manually by the operator or subject by pressing the space key. For most test persons, the automatic validation is a fast and accurate method and therefore recommended to use. If no is selected, each validation point must be accepted manually by pressing the space key.

7. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected
   - and continues playing when "CONTINUE" is selected in the next element
   - or stops when "STOP" or another file is selected in the next element

---

**Recording of Audio with stimuli:** If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.

---

**Direct Button**

**Direct Button "Target Shape"** opens the target shape selection dialog. Please select one of the predefined validation targets or an user defined target.

User defined targets can be static images (bmp, jpg, png) or animated targets (gif).
Direct Button "Validate Now" starts immediately a validation (if Experiment Center is connected with iView X).
6.3.6.3  Text Stimulus Element

A text stimulus is entered in a special editor window provided by Experiment Center (see Text Editor Window). The text editor allows you to edit the text content while displaying the end result visible later during the experiment ("WYSIWYG").

This is especially true if you press [F12] to toggle between full screen mode and normal mode.

Insert stimulus element

To insert a text stimulus element proceed as follows:

1. Click in the top toolbar.

The text editor window opens.

2. Enter new text or paste it from the clipboard. Alternatively, click to open an existing RTF text file. Use the toolbar buttons to format the text.

   Note: An imported RTF text may carry objects (e.g. images, spreadsheets) which cannot be displayed as text. It may be valuable to choose a text that is not too long to assure the performance.

3. To close the text editor, click its OK button.

   In the Application Window, a new text stimulus element is added to the list of stimuli.
The Experiment Center text editor provides only basic text editing capabilities. If more formatting is required, please use a word processing program like MS WinWord or OpenOffice Writer to format your text and copy it to the Experiment Center Editor via clipboard.

**Edit stimulus element**

To edit the properties of the text stimulus element proceed as follows:

1. Select the element. You can check its design in the preview pane on the right.

2. **Background Color** field: Click on to open the color selection dialog, offering separate color tabs. Select the desired background color.

   Note: If you select "transparent", the frame color will be the color you selected in "Calibration". See also **Edit calibration settings**

3. In the properties window, enter the transition time in the **Duration** field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "auto" keyword if you want to proceed manually using the [SPACE] key, the [>] key, or [F11].

4. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.
5. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

6. In the **Presentation Width [Pixel]** field, the presentation (rendering) of the text on the stimulus display can be limited to a smaller area than the screen width. If a value smaller than the current screen width resolution is entered, the text area is centered on the screen with left and right borders. The default value is "screen width", which means that the text is automatically rendered to the full screen resolution.

7. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

*Mouse clicks and key presses (except function keys) are always automatically recorded.*

*The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.*

*Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.*

**Change text inside of the stimulus element**

If necessary, you can edit the text, e.g. to change its font size or alignment.
Direct Button "Edit"

1. Press the Edit button on top of the preview pane
2. Edit the test and/or change its properties.
3. Click OK to close the text editor window.

Direct Button "Trigger AOI"

1. Use the direct button Add Trigger AOI in the preview pane to add an AOI on the text. During execution the AOI is not visible and triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into that area. The AOI can be moved and changed in size within the text area.
2. Edit the Dwell time in ms which should be used dwell time to trigger the next stimuli. The default dwell time is 1000ms.

If the reading package is licensed, AOIs on text elements for further analysis in BeGaze 2.4 are automatic generated during experiment execution.
6.3.6.4 Questionnaire Element

The questionnaire element adds custom questions with multiple choice and free text answers. Furthermore the answers can be assigned to subject properties (e.g. gender, age group) that allow you to use them in BeGaze for filtering. The questions are automatically rendered on the stimulus screen.

**Insert stimulus element**

To insert a question stimulus element proceed as follows:

1. Click ![question symbol] in the top toolbar.

The question editor opens.
2. Enter your question. Example: What is your gender?

3. Enter your answers.
   1. Press "Add answer" to add a pre-defined multiple choice answer.
   2. Press "Add free text" to add a free text field as an answer, represented by "..." in the answer list.

4. If needed, select an existing subject property (e.g. gender) from the "Assign to subject property" list.
   If the subject property doesn't exist, you can create a new subject property by pressing the button "Subject Property Editor".

   If you select an existing subject property and the entered value made by the operator differs from the entered value of the subject, the second one will overwrite the first in the BeGaze 2.4 analysis.

5. In case the subject shall be able to select multiple answers from the "multiple choice selection", please check the "Allow multiple answers" checkbox. In this case, it is not possible to assign an answer to a subject property.

6. To close the question editor, click its OK button.

**Edit stimulus element**

**Direct Button "Edit"**

Use the direct button Edit to open the question editor in order to modify your questions and answers.

**Property Window**

To edit the properties of an image stimulus element proceed as follows:

1. Select the element. You can check it in the preview window.

2. **Background Color** field: Click on ✗ to open the color selection dialog, offering separate color tabs. Select the desired background color.
3. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

4. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

   ![](i) The question results are stored for all subjects in the result directory in one xml and csv file. In addition, BeGaze is presenting them in the questionnaire template of the statistics module.

   ![](i) **Recording of Audio with stimuli**: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see [Global Settings](#)). Audio recording requires a valid license of the Observation package.
6.3.6.5 Image Stimulus Element

You can use a single image in your experiment as well as a series of images to perform a slideshow.

Insert stimulus element

To insert an image stimulus element proceed as follows:

1. Click in the top toolbar.

   The Select Image dialog opens.

2. Select the desired image from the directory list (*.bmp, *.jpg, *.png, *.wmf, or *.tif files). You can also select multiple images from the directory.

3. Click Open.

   In the Application Window, a new image stimulus element is added to the list of stimuli. If you have selected multiple images, each image is added as a separate stimulus element.

Edit stimulus element

Direct Button

1. Use the direct button Add Trigger AOI in the preview pane to add an AOI on the picture. During execution, this area is not visible and triggers the presentation of the next stimuli when the respondent looked more than "Dwell time" milliseconds into that area. The AOI can be moved and changed in size within the picture.

2. Edit the Dwell time in ms which should be used as dwell time to trigger the next stimuli. The default dwell time is 1000ms.

Property Window

To edit the properties of an image stimulus element proceed as follows:
1. Select the element. You can check it in the preview window on the right.

2. In the properties window, enter the transition time in the **Duration** field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the [SPACE] key, the [>] key, or [F11].

3. In the **Fit Image to Screen** field, click to open a drop-down list. Select **Yes** to display the image in full screen mode. Note that the scaling preserves the aspect ratio of the image. Select **No** if you want to keep the image's original size. The display area not covered by the stimulus is filled with the calibration background color.

4. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

5. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

6. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

**Recording of Audio with stimuli:** If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see **Global Settings**). Audio recording requires a valid license of the Observation package.
Mouse clicks and key presses (except function keys) are always automatically recorded.

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.
6.3.6.6 Web Stimulus Element

You can use a web site in your experiment. The web site needs to be viewable with the installed Microsoft Internet Explorer.

Insert stimulus element

To insert a web stimulus element proceed as follows:

Click ![Web Button](image) in the top toolbar. In the Application Window, a new web stimulus element is added to the list of stimuli.

Edit stimulus element

1. In the properties window, enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the web element stops and the next stimulus element will be presented. Enter the “manual” keyword if you want to proceed manually using the function key \[F11\].

2. In the Web address (URL) field of the properties pane, enter the desired URL. The web stimulus browser displayed during the experiment will start with this URL later on. The Home button of the browser navigates to this URL also.

3. In the Navigation Bar field, click ![Drop-down List](image) to open a drop-down list. Select visible if the navigation bar should be visible for the subject during the experiment run. Otherwise select invisible.

4. In the Background Screen Recording field, click ![Drop-down List](image) to open a drop-down list. Select Yes if a screen recording video with a fixed rate of 10fps should be recorded in parallel, while the subject is operating the web stimulus browser. Please always have in mind that screen recording is taking a lot of processor performance. Otherwise select No (default).
5. In the **Presentation Width [Pixel]** field, the presentation (rendering) of the text on the stimulus display can be limited to a smaller area than the screen width. If a value smaller than the current screen width resolution is entered, the browser area is centered on the screen with left and right borders. The default value is "screen width", which means that the browser is automatically rendered to the full screen resolution.

6. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

   ![Information icon](image)

   **Mouse clicks and key presses (except function keys) are always automatically recorded.**

   ![Information icon](image)

   **The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.**

The subject uses the web browser during the experiment similar to a standard web browser. All interactions to the web page like entering text, clicking on links, etc. are allowed. The user can also change the address field of the browser.

The web browser offers the following control buttons:

- ![Backward](image) Navigates to the previous history entry
- ![Reload](image) Reloads the current web page
- ![Forward](image) Navigates to the next history entry
- ![Stop](image) Stops loading the current web page
- ![Exit](image) Stops web browsing and presents next stimulus
- ![Homepage](image) Navigates to the home URL
[F11] key: stops the web browsing stimulus and proceeds with the next stimulus

The web stimulus element is mainly designed to analyze visual attention for multiple users and user groups. To achieve the best possible comparison between different users, there are some limitations regarding active web content. Note that the navigation from web page to web page is also recorded in the Subject Protocol.[95]

Recording of gaze data starts when the web site starts to load. In addition, a user message “URL completely loaded” is generated and stored in the *.idf file when the web site is completely loaded which can be analyzed together with the gaze data in BeGaze 2.4.

⚠️ The interaction between web browser developers and web page designers comprises the continued technical evolution of web content. For this reason, web pages exist which cannot be used for gaze tracking experiments. This especially includes active content such as movie sites, online games, various Web 2.0 content, incompatible HTML, or failing script code.

ℹ️ Analysis of pop-up windows is not supported. Pop-up windows are automatically discarded/suppressed.

ℹ️ Recording of Audio with stimuli: If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings[19]). Audio recording requires a valid license of the Observation package.
6.3.6.7 Movie Stimulus Element

You can use a movie file in your experiment. The movie file needs to be playable with the installed Microsoft Media Player (see Supported File Formats).

Insert stimulus element

To insert a movie/video stimulus element proceed as follows:

1. Click in the top toolbar.
   The Select Movie dialog opens.
2. Select the desired movie from the directory list. You can also select multiple movies from the directory.
3. Click Open.
   In the Application Window, a new movie stimulus element is added to the list of stimuli. If you have selected multiple movies, each movie is added as a separate stimulus element.

Movies are automatically re-encoded during import if they are not stored in an optimized format. Optimized format means that the videos can be analyzed at its best performance afterwards in BeGaze. Therefore the videos are re-encoded using the XMP4 codec with settings that allow best seek performance. It might be possible that the video quality is slightly effected after re-encoding.

Supported file formats (before optimization) are avi, wmv, asf, mpg, mpeg, mpe, vob, mp4, m4v, mkv. It must be ensured from the creator of the experiment that the video codec which is necessary to play back the original video is installed on the Experiment Center PC.

Edit stimulus element

To edit the properties of a movie stimulus element proceed as follows:
1. Select the element. You can check it in the preview window on the right.

2. In the properties pane, enter the transition time in the **Duration** field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the movie stops and the next stimulus element will be presented. Enter the “manual” keyword if you want to play the movie until it’s end or proceed manually using the [SPACE] key, the [>] key, or [F11].

3. In the **Fit Movie to Screen** field, click to open a drop-down list. Select **Yes** to display the move in full screen mode. Note that the scaling preserves the aspect ratio of the movie. Select **No** if you want to keep the movie’s original size. The display area not covered by the stimulus is filled with the calibration background color.

4. **Record Data** field: If no is selected, the recoding of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

5. **Show Mouse Cursor** field: The mouse cursor is either hidden (no = default) or shown (yes) on the stimulus screen during experiment execution.

6. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

---

**Recording of Audio with stimuli:** If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see Global Settings). Audio recording requires a valid license of the Observation package.
Mouse clicks and key presses (except function keys) are always automatically recorded.

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

6.3.6.8 Screen Recording Stimulus Element

You can include a screen recording in your experiment. A screen recording is an arbitrary application that the subject can use at will. Experiment Center concurrently records a screen capture video of all actions the subject performs when operating the application.

Insert stimulus element

To insert a screen recording stimulus element proceed as follows:

1. Click in the top toolbar.

In the Application Window, a new screen recording stimulus element is added to the list of stimuli.

The subject uses the application during the experiment. All interactions to the application like entering text, clicking on buttons, etc. are captured from the screen and saved to a video file while concurrently monitoring the gaze position. The operator or the subject ends the application using the [F11] key.

Note that the screen recording does not end if the subject exits the application. Using this feature, it is possible to monitor further screen interaction of the subject, such as restarting an application or working with several applications started successively.

Note that screen recording doesn’t terminate applications that are
started together with screen recording when screen recording stops.

**Edit stimulus element**

**Direct Button "Gaze Cursor"**

Press the Gaze Cursor button to load the following dialog.

1. Record gaze cursor overlay
2. Use gaze cursor filter

   The "gaze cursor filter" filters the data used to draw the overlay in the
video. This filter affects only the overlay cursor and does not influence recorded gaze data.

Filter Depth: The overlay output filter reduces noise by averaging the data over a period of time. The time can be set from 0 ms to 500 ms.

Saccade Length: If saccades are detected the gaze cursor filter will be switched off. The jump of the cursor will be clearly visible and not be smoothed. The minimum saccade length can be set from 0 to 500 pixels.

When the data needs to be analyzed in BeGaze, it is recommended to switch off the gaze cursor overlay but at least to switch off the "smoothing" gaze cursor filter.

Property Window

To edit the properties of a screen recording stimulus element proceed as follows:

1. Select the element.

2. In the properties window, enter the transition time in the Duration field (min. 500 milliseconds). The duration time can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the range. After this duration has elapsed, the screen recording element stops and the next stimulus element will be presented. Enter the "manual" keyword if you want to proceed manually using the function key [F11].

3. Application to start field: Click the button if you want to select another application.

4. Arguments field: Enter arbitrary arguments added to the application's command line. Most applications will accept arguments, such as one or more file names to be opened or a web URL to be loaded.

5. Frames per second field: This number determines how many frames per second are captured and encoded into the resulting capture video. Possible values range from 1 to 25 frames per second.

It is not recommended to use higher values than 10 in One-PC-
configurations. Note that screen recording requires a very high system load which in turn may influence the application's function, the iView X gaze tracking and can cause frame drops in the recorded video. How many frames are possible for your purposes also depends on your CPU and graphics card driver resources. For example, capturing 10 frames per second on a 1680x1050x32 display requires to capture and encode 70 Megabyte/second in realtime.

6. **Record Data** field: If no is selected, the recording of eye and gaze data is paused while this stimulus is shown and therefore not available in the later analysis.

7. **Audio playback** field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected

   - and continues playing when "CONTINUE" is selected in the next element

   - or stops when "STOP" or another file is selected in the next element

**Recording of Audio with stimuli:** If the audio content from "audio playback" is needed in the analysis with BeGaze, the loudspeaker output has to be connected to the microphone input and audio recording must be enabled (see **Global Settings**). Audio recording requires a valid license of the Observation package.

Mouse clicks and key presses (except function keys) are always automatically recorded.

The duration time can be set to a time range. The duration time is randomized within this range. After elapsing, the next element will be presented.

Please read the **System Limitations** chapter.
6.3.6.9 External Video Source Element

You can connect an external video source such as game console, TV etc. to include it in your experiment.

Please see Installation and Setup of External Video before inserting the stimulus element.

Insert stimulus element

Click in the top toolbar. In the Application Window, a new external video stimulus element is added to the list of stimuli.

Edit stimulus element

Direct Button "Gaze Cursor"

Press the Gaze Cursor button to load the following dialog.
1. Record gaze cursor overlay

2. Use gaze cursor filter

The "gaze cursor filter" filters the data used to draw the overlay in the video. This filter affects only the overlay cursor and does not influence recorded gaze data.

Filter Depth: The overlay output filter reduces noise by averaging the data over a period of time. The time can be set from 0 ms to 500 ms.
Saccade Length: If saccades are detected the gaze cursor filter will be switched off. The jump of the cursor will be clearly visible and not be smoothed. The minimum saccade length can be set from 0 to 500 pixels.

When the data needs to be analyzed in BeGaze, it is recommended to switch off the gaze cursor overlay but at least to switch off the "smoothing" gaze cursor filter.

Direct Button "Video Source"

Press the Video Source button to load the following dialog.

1. Select your video source. A preview appears.
2. You can also select your previous adjusted sound to be recorded.
3. Press OK.
4. In the properties window, choose whether you want to Record Data or not.
5. Audio Playback field: An audio file (wav, mp3, wma) can be loaded with "Select a file" which is played back independently of the presented stimulus. The playback starts with the element where the audio file has been selected.
6.3.7 Randomization - Groups and Duration

The following randomizations options are available
- Randomization of the presentation order of the stimuli
- Randomization of the presentation time for each stimulus

**Randomization Groups**

You can combine multiple stimuli in a so-called randomization group. These stimuli are presented in a random order in an experiment run whereas the order changes for each experiment trial.

Randomization groups can be mixed up within the stimuli arrangement. While stimuli which are combined in a group are presented in a random order, the group position itself in the overall sequence of stimuli is absolute. It is possible to use one or more randomization groups in an experiment and also to cascade them.

Example:
The illustration shows the stimuli order of an experiment with five randomization groups. The order of stimuli presentation may be:

<table>
<thead>
<tr>
<th>First trial</th>
<th>Second trial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text 1 (group 1)</td>
<td>Text 2 (group 1)</td>
</tr>
<tr>
<td>Image 2, 3, 1 (group 2)</td>
<td>Image 1, 3, 2 (group 2)</td>
</tr>
<tr>
<td>Image 4, 5 (group 3)</td>
<td>Image 5, 4 (group 3)</td>
</tr>
<tr>
<td>Text 2 (group 1)</td>
<td>Text 1 (group 1)</td>
</tr>
<tr>
<td>Image 10, 6 (group 4)</td>
<td>Image 6, 10 (group 4)</td>
</tr>
<tr>
<td>Image 9, 7, 8 (group 5)</td>
<td>Image 8, 7, 9 (group 5)</td>
</tr>
<tr>
<td>Text 3 (no group)</td>
<td>Text 3 (no group)</td>
</tr>
</tbody>
</table>

A stimulus which is not allocated to a randomization group will be presented at that position where it is placed in the stimuli sequence. In the example above, this is the case for the “Text 3” element.

**Combine stimuli in a randomization group**

To add a stimulus to a randomization group proceed as follows:

1. If the experiment is locked, click 🔒 to unlock.
2. Select the appropriate stimulus element in the list of stimuli.
3. Enter a group name (a number or a text) in the Random Group column. If you have already assigned group names within the experiment, you can alternatively click the ▾ button and select the desired group from the drop-down list.

The Subject Protocol contains the sequence and time stamps of the randomized stimuli for each trial.
Randomization of Duration

The duration time of stimuli (where applicable) can either be a fixed value in ms or a time range larger than 500ms, e.g. 500-4000. In case of a time range, the duration time is randomized within the given limits.
6.3.8  Subject Properties

For use in the BeGaze 2.4 application, you can define individual subject “group” parameters for the experiment. These parameters are entered as subject properties and serve as additional information to your experiment. Useful properties may be “Age” and “Gender”. The subject properties are stored as meta information in a separate file written to the experiment’s results directory.

Add subject property

To add new subject properties proceed as follows:

1. In the Extras menu, select the Subject Property Editor command. The Subject Property Editor dialog opens.

2. Click Add.

3. In the following Please enter the property name dialog enter the name of the new property, e.g. "Age".
4. Click OK to confirm your entry.

When you start a new experiment, the **Please enter subject information** dialog opens where you can enter the individual subject’s data (see Starting New Subject).

If you select an existing subject property and the entered value made by the operator differs from the entered value of the subject, the second one will overwrite the first in the BeGaze 2.4 analysis.

### Delete subject property

To delete subject properties proceed as follows:

1. In the Extras menu, select the Subject Property Editor command. The **Subject Property Editor** dialog opens. The Property Name list displays the already defined properties.

2. Select the property you want to delete.

3. Click Delete.
6.3.9 Annotations

Annotations can be used during recording for coding of user specific behaviour.

Required system setup

A system setup with two keyboards and two monitors is required to use the annotation capabilities.

One keyboard is for the use of the subject, the second keyboard is for the use of the operator.

The keyboards are detected automatically when the recording starts.

Except of the function keys, both keyboards are working independently. The subject can use the keyboard as normal, e.g. in order to perform a Web task, while the operator can use the keyboard to generate and edit annotations during runtime. The complete annotation handling for the operator can be done only by using the keyboard without using the mouse.

The function keys on both keyboards can still be used to control the experiment flow.

⚠️ Experiment Center must be visible on the operator monitor.

Define Annotations

Annotations can be defined in the Annotation Editor that can be found under Extras -> Annotation Editor.
A default type annotation is always being present. The definition of the default annotation can be changed.

A set of defined annotations is stored together with the current open experiment and the experiment results.

The range of types is from A-Z and will be used in conjunction with CTRL to generate the annotations during runtime.

**Add Annotation**
- Press Add Annotation to create a new line in the list
- Select an unused character from the type list
- Modify the color if needed
- Define the annotation in the Definition field

**Delete Annotation**
- Select an entry in the list
- Press Delete Annotation
Save Annotations

Annotations are saved automatically. By pressing **Save Annotations**, the current set of annotations can be saved (exported) as a xml file in order to use them later on in other experiments as well.

Load Annotations

Press **Load Annotations** to load a formerly created set of annotation. The current list will be overwritten.

Use annotations during runtime

During runtime, the operator can "fire" annotations in realtime using [CTRL - ENTER] for the default annotation or [CTRL] plus the character as defined in **Type** for a specific annotation.

After the shortcut has been pressed, the following annotation dialog appears on the operator monitor.

The **Type** of annotation is preselected based on the used short cut, e.g. CTRL-Enter is showing the default entry. You can also select another annotation type if necessary.
Press Tab to go to the **Text Notes** field and enter custom text (optional).

Press Tab to go to the **Operator Name** field where you can enter your name or initials (optional).

Press Tab to go to the **Time Offset** field (optional). Besides the values above, the timestamp of the annotation is saved as well. The timestamp is the time when the annotation has been "fired" by the operator using the shortcuts. This timestamp is being used in BeGaze to position the annotation on the correct position in the timeline. It might be useful to correct the timestamp when you've experienced, for example, a reaction delay of the operator to fire the annotations. In this case you can enter here a value in seconds which subtracts the number of seconds from the timestamp.

Press Tab to go to the button **OK** and press Enter.

> **Annotations can also be set even though they've not been specified before.** You can select any type from the list (A-Z) and specify the meaning/description afterwards.

**Annotations in BeGaze**

BeGaze automatically reads the annotation definitions and use them to show the annotations is the User event list and player control.

BeGaze provides the similar functionality as Experiment Center for annotations and enhanced editing/analysis capabilities.

Please refer to the user manual of BeGaze for further information.
6.4 Running Experiments

6.4.1 Dry Running an Experiment

The dry run of an experiment allows the operator to check the experiment settings before it is used. The dry run is a test scenario evaluation – without calibration and recording.

Prerequisites

Before you start the dry run, ensure that

- the appropriate experiment is loaded,
- the stimuli properties are set properly.

Dry run experiment

To execute the dry run proceed as follows:

1. Ensure that the experiment is locked ( ). If it is unlocked, click to lock.

2. If you want to display the visual stimulus on a second monitor, select the desired monitor in the Select Stimulus Monitor drop-down list (see Double Monitor Settings ).

3. Click in the bottom toolbar.

   The experiment dry run starts. Calibration is skipped and nothing is recorded.

4. Press [F12] to stop the dry run at any time or click .
6.4.2 Running an Experiment

**Prerequisites**

Before you start recording, ensure that

- the appropriate experiment is loaded (see Loading and Changing an Experiment),
- the calibration properties are set (see Setting Calibration),
- the required stimuli are included (see Setting Stimuli),
- the desired subject properties are defined (see Subject Properties),
- the subject is seated directly in front of the stimulus PC monitor,
- the eye tracking system (iView X) is started and properly connected (see Global Settings),
- and for a double monitor setup, the desired stimulus monitor is attached and switched on (see Double Monitor Settings).

**Main steps**

If all prerequisites are met, a typical recording is executed with these steps:

1. **Start the recording for a new subject**
2. **Run the calibration**
3. **Present stimuli**
4. **End the recording**
6.4.2.1 RED subject placement

If the RED4 or RED/RED250 (Remote Eye tracking Device) is used, the operator controls the placement of the subject using the RED Tracking Monitor.

To view the RED Tracking Monitor, switch to the RED Tracking Monitor tab which is available in the property area displayed in the lower right of the Application Window. Note that the tab control is displayed only if Experiment Center is connected to iView X (see Global Settings).

The operator can double click on the tracking monitor tab in order to present the same view also to the subject on the stimulus monitor.
As a first step, the physical position of the subject is verified using the RED Tracking Monitor calibration display:

- If the eyes are tracked by the system, two white eye ellipses are visible in the scene image. If tracking is lost, the white dots disappear from the scene image.

- If the subject sits too far away from the screen, this arrow indicates that he or she should move closer.

- If the subject sits too close to the screen, this arrow indicates that he or she should increase the distance to the screen.

Other arrows direct the subject to center his or her head in front of the monitor. The subject sits perfectly if all arrows have vanished.
6.4.2.2 Starting New Subject

To start a gaze position recording for a new subject proceed as follows:

1. Ensure that the experiment is locked (🔒). Otherwise, click 🔒 to lock.

2. Ensure that iView X is connected (💻). Otherwise, click to open the Global Settings dialog in order to reconnect.

3. If you want to display the visual stimulus on a second monitor, select the desired monitor in the Select Stimulus Monitor drop-down list or by pressing the [F9] key. Click the Identify button to verify the double monitor setup. The subject should be placed in front of the monitor now identified by a large 2 (Stimulus Monitor) text display.

4. Click or press the [F10] key.

The Please enter subject information dialog opens.
If the entered value made by the operator differs from the entered value of the subject later on, the second one will overwrite the first in the BeGaze 2.4 analysis.

5. Enter the mandatory Subject code. Note that this code is used to build the file name used to store the experiment results for the current trial. Do not use characters not valid for file names, such as “/”, “\”, “:”, “|”, or “<”. Use letters A-Z, digits 0-9, or the space character instead.

6. You may enter a short description for the subject in the Description field. Note that it is possible to add customized input fields to the subject information dialog (see Subject Properties).

7. Click OK.

The stimulus presentation normally starts by running the calibration.

The Windows operating system does not distinguish between upper case and lower case letters in file names. For this reason, make sure the entered subject code does not depend on used letter case.
6.4.2.3 Running Calibration

When calibration starts, a center target will appear on the stimulus monitor. If the Show online data option from the Global Settings dialog is activated, the target as well as the subject's gaze position is visible in the preview area displayed in the upper right of the Application Window.

When the Quality check setting in the calibration element is set to Calibration, the calibration quality dialog is shown after the calibration has been executed. The dialog shows the calculated gaze positions in comparison to the correlated calibration targets. The operator can verify the calibration quality and decide to continue or repeat the calibration if desired.

When Validation is selected, the dialog shows the four additional validation points with the average deviation of the subjects gaze to the validation points. The operator can verify the validation quality and decide to continue or repeat the calibration if desired.
Select best calibration

The calibration can be repeated multiple times and the results are shown in list.

The operator can select the best calibration from that list and continue with these calibration settings.

Calibration and Validation on demand

- Calibration on demand allows to execute a calibration at any point of time during the experiment execution. When the function key F5 is pressed, a temporary calibration element is added in the experiment flow and executed when the currently shown stimulus ends.

- Validation on demand allows to execute a validation at any point of time during the experiment execution. When the function key F8 is pressed, a temporary validation element is added in the experiment flow and executed when the currently shown stimulus ends.

Some calibration methods are showing perfect results when Quality check = Calibration is selected. In this case, it is recommended to change the Quality check to Validation.

For more information about calibration please refer to the iView X Online Help.
6.4.2.3.1 Calibration Tips

To execute the calibration successfully please pay attention to the following guidelines.

- The environmental conditions should be approximately the same between calibration and experiment (esp. light level and subject posture).

- RED: Place the subject in a comfortable position in front of and centered to the stimulus monitor. The subject's chair should not have wheels and pivots to minimize the amount of upper body movements made by the subject. A correct distance of the subject to eye tracking device shall be between 60 and 80 cm.

- Advise the subject to minimize his/her head movements. The subject should look at the target while keeping his/her head still as much as possible.

- You should pay attention to the overall screen stimulus brightness and luminosity. If you present very different stimuli in sequence, the subject's pupil will adapt to the light emitted by the screen. For this reason, the same background color should be used throughout all presented stimuli.
### 6.4.2.4 Stimuli Presentation

After a successful calibration the system processes the experiment by presenting the stimuli. The transition between stimuli can be executed automatically by the system according to the stimuli properties or manually controlled by the operator.

The following tables give an overview of how to control the stimuli presentation and which keyboard shortcuts are active while presenting the respective stimulus. The **Duration** property of each stimulus determines how the transition between stimuli is triggered.

#### Duration property set to “manual”:

<table>
<thead>
<tr>
<th></th>
<th>Text</th>
<th>Questionnaire</th>
<th>Image</th>
<th>Web</th>
<th>Movie</th>
<th>Screen Recording</th>
<th>External Video</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic ends if:</strong></td>
<td>[F11] or [SPACE] or [&gt;] key</td>
<td>[F11] or [SPACE] or [&gt;] key or [Continue] button</td>
<td>[F11] or [SPACE] or [&gt;] key</td>
<td>[F11] or [SPACE] or [&gt;] key</td>
<td>End of movie</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Previous stimulus is presented by:</strong></td>
<td>[&lt;] key</td>
<td>[&lt;] key</td>
<td>[&lt;] key</td>
<td>–</td>
<td>[&lt;] key</td>
<td>–</td>
<td>[&lt;] key</td>
</tr>
</tbody>
</table>

#### Duration property set to a value in milliseconds:
### Step-by-step Instructions

<table>
<thead>
<tr>
<th></th>
<th>Text</th>
<th>Questionnaire</th>
<th>Image</th>
<th>Web</th>
<th>Movie</th>
<th>Screen Recording</th>
<th>External Video</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic ends if:</strong></td>
<td>Timed end</td>
<td>–</td>
<td>Timed end</td>
<td>Timed end</td>
<td>Timed end</td>
<td>Timed end</td>
<td>–</td>
</tr>
<tr>
<td><strong>Next stimulus is presented by:</strong></td>
<td><code>[F11]</code> or <code>[SPACE]</code> or <code>[&gt;]</code> key</td>
<td><code>[F11]</code> or <code>[SPACE]</code> or <code>[&gt;]</code> key or <code>[Continue]</code> button</td>
<td><code>[F11]</code> or <code>[SPACE]</code> or <code>[&gt;]</code> key or <code>[&gt;]</code> key</td>
<td>[EXIT] button</td>
<td>[F11] or [SPACE] or <code>[&gt;]</code> key</td>
<td><code>[F11]</code> or [SPACE] or <code>[&gt;]</code> key</td>
<td></td>
</tr>
<tr>
<td><strong>Previous stimulus is presented by:</strong></td>
<td><code>[&lt;]</code> key</td>
<td><code>[&lt;]</code> key</td>
<td><code>[&lt;]</code> key</td>
<td>–</td>
<td><code>[&lt;]</code> key</td>
<td>–</td>
<td><code>[&lt;]</code> key</td>
</tr>
</tbody>
</table>

---

1. The operator can stop the experiment at any time by pressing `[F12]` or by clicking the button.

2. At any time the operator can force a "calibration on demand" by pressing F5 or a "validation on demand" by pressing F8. The calibration/validation will be executed when the current shown stimuli ends and before the next stimulus is shown.

3. Annotations can be created at any time from the operator when a second keyboard is being used.
6.4.2.5 Create Annotations

Please see the Annotations section.

6.4.2.6 Ending Recording

The recording stops automatically after all stimuli have been presented to the subject. Alternatively, click the button or press the [F12] key to stop at any time.

Note that all data for the actual subject are always saved into the respective *.idf file, even if you stopped the recording using the [F12] key. Also, the Subject Protocol is presented at the end of the recording.

All files belonging to an experiment will be saved automatically in the experiment folder to the results subdirectory. The trial separations are created automatically in the respective *.idf file.

When the experiment is finished, you can optionally start BeGaze 2.4 to analyze the experiment data or export the experiment data via the button.
6.4.2.7   Subject Protocol

A subject protocol is created automatically for each experiment run.

The protocol for each subject is stored as CSV compatible text file in the results folder (*.txt). Each protocol text file contains lines with the following data fields:

- the experiment's name.
- the subject code entered in the subject information dialog.
- the time stamp for the stimulus or event (Hour, Minute, Second, Millisecond from start of trial).
- the stimulus type such as “Text”, “Screen Recording”, “Web”, or the event type such as “Loaded” for finishing to load a web page while running the web stimulus. Especially, the web page URL protocol may be used for web click analysis or for web landing page analysis (see Web Stimulus Element).
- the stimulus or event content such as file names for images, movies and text stimuli, the web page address for the web stimulus / load event, or the executable name and parameters for the screen recording stimulus.

i BeGaze extracts the last calibration/validation deviation values from the logfiles and shows them in the subjects statistics template of BeGaze.
6.4.3 Analyzing Experiment Data

For analysis purposes you can view the recorded measurement data in BeGaze 2.4. The experiment's results are stored in *.idf files which are located in the ..\results subdirectory. You can load one of these files in the BeGaze 2.4 application for visualization and further analysis.

1. Run and end the experiment (see Running an Experiment and Subject Protocol).

2. To further analyze the experiment, click the BeGaze button in the lower right corner in order to start BeGaze 2.4 and to automatically load the current experiment data into BeGaze 2.4. If the experiment already exists in BeGaze, the existing experiment is being updated with the new data sets. The BeGaze button is enabled if valid data exist and if BeGaze 2.4 is not already running.

For more information about experiment analysis refer to the BeGaze 2.4 Online Help.
User Interface

Chapter VII
7 User Interface

7.1 Application Window

Experiment Center features a user-friendly intuitive interface. All steps for preparing, testing and running an experiment are executed in the Application Window. In the following you find a description of its three working areas.

- At top: Experiment preparation and control area
- In the middle: Experiment setting and preview area
- At bottom: Experiment execution area
**Top: Experiment preparation and control area**

This working area comprises the main menu and the top toolbar. Use the top toolbar buttons and the main menu entries to prepare your experiment and to control it. For detailed information please refer to the help topics entitled Toolbars and Menu Commands.

The title bar indicates the program name.

**Middle: Experiment setting and preview area**

In this area the experiment settings are reported. On the left, the list of elements used as stimuli is presented in a single pane.

On the upper right of this area, the preview pane is located. This pane shows a preview of a stimulus selected in the list of stimuli. Below the preview pane, navigation arrows allow you to display the previous (arrow left) or the next (arrow right) stimulus. While running experiments, this area also shows the current stimulus together with the subject's online gaze cursor.

On the lower right you find the properties area which shows information on a selected stimulus element. While running experiments using the RED gaze tracking device, this area can be switched to the tab showing the RED Tracking Monitor. When a user camera is selected, this area can be switched to the tab showing the user camera video.

**Bottom: Experiment execution area**

This area serves to configure and run the experiment. Use the buttons in this area to test the experiment (so-called "dry run") and to execute it. Moreover, you can export the experiment results to the BeGaze 2.4 program for further analysis. For detailed information please refer to the help topic entitled Toolbars. For information on how to run experiments please refer to the help book entitled Step-by-step Instructions.
Experiment Center can be operated with separate monitors for the operator and the subject (see Double Monitor Settings). In this case the operator has to select and identify the appropriate monitor where the stimuli are presented to the subject. For this, the experiment execution area contains the Select Stimulus Monitor drop-down list and the corresponding Identify command. For more information on operating modes please refer to the topic entitled Basic Operation.

7.2 Toolbars

Top toolbar

The toolbar is at the top of the Experiment Center Application Window. It gives you short-cuts to important features to prepare and set up an experiment. The top toolbar consists of three units. Here is an overview of the buttons and what they are for:

Experiment storage

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄 New</td>
<td>Creates a new experiment</td>
</tr>
<tr>
<td>📜 Open</td>
<td>Opens an existing experiment</td>
</tr>
<tr>
<td>🔄 Save</td>
<td>Saves the experiment with given name</td>
</tr>
</tbody>
</table>

Experiment elements selection
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td>Adds calibration entry into the list of stimuli</td>
</tr>
<tr>
<td>Validation</td>
<td>Adds validation to the list</td>
</tr>
<tr>
<td>Text</td>
<td>Adds text stimulus element</td>
</tr>
<tr>
<td>Questionnaire</td>
<td>Adds a question element</td>
</tr>
<tr>
<td>Image</td>
<td>Adds image stimulus element (*.bmp, *.jpg, *.gif, *.png, *.wmf, or *.tif file)</td>
</tr>
<tr>
<td>Web</td>
<td>Adds web stimulus element (URL)</td>
</tr>
<tr>
<td>Movie</td>
<td>Adds movie stimulus element (* .avi file)</td>
</tr>
<tr>
<td>Screen Recording</td>
<td>Adds screen recording stimulus element</td>
</tr>
<tr>
<td>External Video</td>
<td>Adds external videos sources as stimulus element</td>
</tr>
</tbody>
</table>

**Experiment control**
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlocked</td>
<td>Locks the experiment so that the current settings cannot be changed accidentally. The buttons of the experiment elements section are disabled.</td>
</tr>
<tr>
<td>Locked</td>
<td>Unlock the experiment so that the current settings can be changed.</td>
</tr>
<tr>
<td>Connected / Disconnected</td>
<td>Indicates whether or not Experiment Center is connected with iView X. Click this button to open the Global Settings dialog.</td>
</tr>
</tbody>
</table>

**Bottom toolbar**

On the bottom of the Application Window, you find commands to run an experiment and export experiment data. To perform these actions, use the following buttons:
### Button | Function
--- | ---
Identify | Identifies the current stimulus monitor
Dry Run | Runs experiment for test purposes (without calibration and recording)
Record | Starts the trial to show stimuli while recording the subject’s gaze position
Stop | Stops a running trial - same as the [F12] function key
BeGaze | Automatically creates or updates the experiment in BeGaze 2.4 – which is opened for analysis. This button is enabled if BeGaze 2.4 is currently not running and there are results available for the loaded experiment.

On the bottom toolbar, you also find the **Select Stimulus Monitor** drop-down list. This menu is necessary to select the monitor in dual screen mode (see **Double Monitor Settings**).

### 7.3 Menu Commands

The Experiment Center software includes the following menu entries:

**File menu** | Function
--- | ---
New | Creates a new experiment ([Ctrl + N])
Open | Opens an existing experiment ([Ctrl + O])
Save | Saves the experiment with given name ([Ctrl + S])
Save as… | Saves the experiment with new name
File menu Function
New Creates a new experiment ([Ctrl + N])
Open Opens an existing experiment ([Ctrl + O])
Delete Experiments Removes one or more experiments from the database
Import Imports experiments (*.zep - file)
Export Exports results of experiments (*.zrs - file)
Quit Quits program ([Alt + F4])

Edit menu Function
Undo Undoes the last change ([Ctrl + Z])
Redo Redoes the last change ([Ctrl + Y])
Copy Copies an element ([Ctrl + C])
Paste Pastes an element ([Ctrl + V])

Insert menu Function
Calibration Adds calibration entry into the list of stimuli
Text Adds text (plain text) stimulus element ([Ctrl + T])
Questionnaire Adds a question as stimulus element ([Ctrl + Q])
Image Adds image stimulus element (e.g. *.jpg or *.bmp file) ([Ctrl + I])
### Insert menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td>Adds calibration entry into the list of stimuli</td>
</tr>
<tr>
<td>Text</td>
<td>Adds text (plain text) stimulus element ([Ctrl + T])</td>
</tr>
<tr>
<td>Web</td>
<td>Adds web stimulus element (URL) ([Ctrl + W])</td>
</tr>
<tr>
<td>Movie</td>
<td>Adds movie stimulus element (e.g. *.avi or *.mpg file) ([Ctrl + M])</td>
</tr>
<tr>
<td>Screen Recording</td>
<td>Adds screen recording stimulus element ([Ctrl + R])</td>
</tr>
<tr>
<td>External Video</td>
<td>Adds external video source as stimuli elements ([Ctrl + E])</td>
</tr>
</tbody>
</table>

### Extras menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Calibration</td>
<td>Runs calibration outside of experiment</td>
</tr>
<tr>
<td>Dry Run Experiment</td>
<td>Runs experiment for test purposes (without calibration and recording) ([F9])</td>
</tr>
<tr>
<td>Global Settings</td>
<td>Opens the <strong>Global Settings</strong> dialog</td>
</tr>
<tr>
<td>Subject Property Editor</td>
<td>Opens the <strong>Subject Properties</strong> dialog</td>
</tr>
<tr>
<td>Annotation Editor</td>
<td>Opens the <strong>Annotation Editor</strong> dialog</td>
</tr>
<tr>
<td>RED Operation Mode</td>
<td>Opens the <strong>RED Operation Mode</strong> dialog</td>
</tr>
</tbody>
</table>

### ? (Help) menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Opens the Online Help ([F1])</td>
</tr>
<tr>
<td>About</td>
<td>Shows information about Experiment Center</td>
</tr>
</tbody>
</table>
### 7.4 Keys Overview

Several functions of Experiment Center can be executed using keyboard commands. The following tables give you an overview.

**Keyboard commands while editing an experiment**

<table>
<thead>
<tr>
<th>Press [...] key</th>
<th>to …</th>
</tr>
</thead>
<tbody>
<tr>
<td>[CTRL] + [N]</td>
<td>create a new experiment.</td>
</tr>
<tr>
<td>[CTRL] + [O]</td>
<td>open an experiment.</td>
</tr>
<tr>
<td>[CTRL] + [S]</td>
<td>save the experiment.</td>
</tr>
<tr>
<td>[DEL]</td>
<td>delete a selected stimulus element from the list of stimuli.</td>
</tr>
<tr>
<td>[CTRL] + [C]</td>
<td>copy a stimulus element.</td>
</tr>
<tr>
<td>[CTRL] + [V]</td>
<td>paste a stimulus element.</td>
</tr>
<tr>
<td>[CTRL] + [T]</td>
<td>insert a new text stimulus.</td>
</tr>
<tr>
<td>[CTRL] + [Q]</td>
<td>insert a new question</td>
</tr>
<tr>
<td>[CTRL] + [I]</td>
<td>insert a new image stimulus.</td>
</tr>
<tr>
<td>[CTRL] + [W]</td>
<td>insert a new web stimulus.</td>
</tr>
<tr>
<td>[CTRL] + [M]</td>
<td>insert a new movie stimulus.</td>
</tr>
<tr>
<td>[CTRL] + [R]</td>
<td>insert a new screen recording stimulus.</td>
</tr>
<tr>
<td>[CTRL] + [E]</td>
<td>insert a new external video source as stimulus.</td>
</tr>
<tr>
<td>[UP] / [DOWN]</td>
<td>move the cursor in the list of stimuli up and down.</td>
</tr>
<tr>
<td>[TAB]</td>
<td>change the focus to the next screen control.</td>
</tr>
</tbody>
</table>
[SHIFT] + [TAB] change the focus to the previous screen control.

[F9] execute a dry run.

[F10] start the experiment.

[F1] open help.

[F12] switch to full screen mode in text editor (text stimulus).

**Keyboard commands during calibration**

Press [... ] key to ...

[SPACE] accept target fixation during calibration. The next stimulus will be presented to the subject.

[>] accept target fixation during calibration. The next stimulus will be presented to the subject.

[F11] end the calibration and proceed to the next stimulus.

[F12] stop the execution of experiment if calibration is inaccurate.

[<] repeat calibration.

**Keyboard commands while running an experiment**

Press [... ] key to ...

[F5] run a calibration on demand.

[F8] run a validation on demand.

[F11] end the current stimulus presentation and proceed to the next one.

[F12] stop the experiment and interrupt the presentation of stimuli (except Web and Screen Recording stimuli).
to present the next stimulus element to the subject (except Web and Screen Recording stimuli).

[>] to present the next stimulus element to the subject (except Web and Screen Recording stimuli).

[<] to present the previous stimulus element to the subject.

You can also select any menu command by pressing the [ALT] key together with the underlined menu hot key. For example the [ALT] + [F] keyboard combination will open the File menu while a subsequent [ALT] + [A] selects the File: Save as... menu command.

### 7.5 Text Editor Window

To insert and edit text stimulus elements, Experiment Center features a special Text Editor. This editor opens in a new window automatically when you have inserted or selected a text stimulus element in the list of stimuli.

- **Open**  
  Opens an existing *.rtf file.

- **Cut**  
  Cuts the marked text.

- **Copy**  
  Copies the marked text.

- **Paste**  
  Pastes a cut or copied text.

- **Undo**  
  Undoes the last step.
Redo

Redoes the last step.

[Font] Font selection

Changes the font family of the currently marked text.

[Size] Size selection

Changes the font size of the currently marked text.

[bold]

Formats marked text bold. A repeated click on the button cancels the formatting.

[Italic]

Formats marked text italic. A repeated click on the button cancels the formatting.

[Underline]

Underlines marked text. A repeated click on the button cancels the formatting.

Bullets

Adds bullets to the selected paragraph. A repeated click on the button cancels the formatting.

Numbering

Numbers the selected paragraph. After a line break the next paragraph will be numbered consecutively. A repeated click on the button cancels the formatting.

Align left

Formats the selected paragraph left-aligned.

Align Center

Centers the selected paragraph.

Align Right

Formats the selected paragraph right-aligned.

Align Justify

Justifies the selected paragraph.

Increase indent

Increases the left indent of the selected paragraph.

Decrease indent

Decreases the left indent of the selected paragraph.

[Color] text color

Sets the color of the text.
Data Storage
8 Data Storage

8.1 Data Storage Structure

Data Collection

A data collection consists of one or several measurement data files, a number of stimulus images and some additional information you have to provide. We call this collection an "experiment". In an Experiment Center experiment, the assembled measurement data files are called "trials".

Experiment Structure

In a typical gaze tracking experiment, the stimulus changes over time. In order to synchronize the measurement data with changes in stimulus presentation, the data files contain either a "set number" or a "user message" at the onset time of the stimulus change. This synchronizing information can be used to separate each trial into "sets", where each set is associated with a certain stimulus image.
8.1.1 Directory Structure

All accumulating data in a gaze tracking experiment will be saved automatically by Experiment Center. They are saved in two different directories created under the configured data path (see Global Settings).

For each experiment, Experiment Center creates two subdirectories to store experiment data:

- **Experiments**: this directory contains the experiment file (*.EXP) as well as used media such as *.RTF, *.BMP, etc. By default, this directory resides under the program installation directory:
  
  C:\Program Files\SMI\Experiment Suite 360\Experiment Center 2 \Experiments\[Experiment Name].

- **Results**: this directory contains the experiment results files including the eye tracking data files (idf). The IDF files are written by the iView X system which responds to the respective commands Experiment Center sends during runtime. By default, this directory resides under the program installation directory:
  
  C:\Program Files\SMI\Experiment Suite 360\Experiment Center 2 \Results\[Experiment Name].

*With a double PC setup, both directories need to be located on a shared drive writeable from both PCs.*
8.1.2 Importing and Exporting Experiments

Experiment Center supports the import and export of experiments and results to backup or exchange them.

Export of Experiments
From the File menu, select Export Experiments. Select one or more experiments from the dialog and press "Export". Each experiment export file is stored in the name convention of experiment name followed by the suffix ".zep".

Export of Results
From the File menu, select Export Results. Select one or more experiments from the dialog and press "Export". Each result export file is stored in the name convention of experiment name followed by the suffix ".zrs".

Import of Experiments
From the File menu, select Import Experiments. Select one or more Experiment export files (*.zep) from the file dialog. The experiment export files are unpacked into the experiment main directory as defined in the Global Settings.

If the experiment already exists, the import is skipped. In this case, please save the already existing experiment under a new name ("Save as...") and delete it afterwards ("Delete experiment").

Import of Results
From the File menu, select Import Results. Select one or more Result export files (*.zrs) from the file dialog. The result export files are unpacked into the result main directory as defined in the Global Settings.

Do not rename the experiment in the result folder manually. The folder's name is the name of the experiment - which needs to match the file name of the included *.exp and *.mtd files.
8.2 Experiment Files

All files used to create an experiment are stored in a subdirectory under the current Experiment Path setting (see Global Settings). This subdirectory is created when saving the experiment.

The contents of the experiments subdirectory are:

- An *.exp file including the experiment description, the experiment specific settings, as well as all used stimuli with their properties.
- All source files used as stimuli.

**Example:**

In the following example, the operator entered "slideshow" at the experiment saving prompt.

...\experiments\slideshow\n
    slideshow.exp
    textfile.rtf
    moviefile.avi
    imagefile.bmp
8.3 Results Files

All files used to execute an experiment are stored in a subdirectory under the current **Results Path** setting (see **Global Settings**). This subdirectory is created when recording the experiment.

The contents of the results subdirectory are:

- Several *idf* files which contain the measured gaze tracking data – one for each subject. The *idf* file has the following naming convention:

  `<subject name>-<experiment name>-<trial number>.idf`

- A protocol text file for each subject with the following naming convention:

  `<subject name>-<experiment name>-<trial number>.txt`

- Files containing the rendered visual stimuli for analyzing the experiment with the BeGaze 2.4 software. The file names of these files are also used as trial separations in the *idf* file.

- Files containing experiment workflow, subject property information and automatic generated AOI information.

During a calibration, the idf file recording is interrupted. For this reason, the files stored in the results folder do not include the calibration.

**Rendered stimuli reference**

The presented text and image stimuli are stored as rendered single bitmap files based on screenshots during experiment execution. The naming convention is:

Text:   `text<increasing number>.jpg`

Image:  `<original filename>.jpg`

Image files are stored in a high-quality jpg format using a quality value of 90.
Web stimuli are stored as a single bitmap of each presented web site (represented by an unique URL). The naming convention is:

Web: <URL with replaced special characters>.jpg

Movies will be copied from the experiment's to the result's directory. The naming convention is:

Movie: <original filename>.avi

Screen recording stimuli will record screenshots written to an avi file. The naming convention is:

Screen Recording: <filename>-<subjectname>-<trial number>.avi

**Example:**

In the following example, the operator entered "slideshow " at the experiment saving prompt.

\results\slideshow\  

subjectname-slideshow-1.idf  
subjectname-slideshow-1.txt  
textfile1.jpg  
imagefile1.jpg  
moviefile1.avi  
filename-slideshow-1.avi
8.4 Supported File Formats

Experiment Center supports different file formats. While the Experiment Center files and the gaze tracking data are specific to SMI software, all media components presented as stimuli are generally supported by the underlying Windows operating system and the Windows Media Player. For this reason, it is possible to use third party tools and software to create or change media files which are used as stimulus, provided that the following file formats are supported:

Text Media

All text media are stored as RTF (Rich Text Format). Experiment Center supports a subset of the RTF file format specification, which includes basic font attribution, font size, alignment, and indenting and list formats.

It is possible to import ASCII text with the text editing component. To use a more complex file as stimulus, for example a file created with Microsoft Word, you may filter the file by copying and pasting the contents via the Windows clipboard.

Image Media

For image media, the following file formats are supported:

- BMP: an older file format supported on all Windows versions; has different color depth variants, such as black & white, 16 colors, 256 colors, and true color.
- JPG: preferred for photographic images; true color model only; saves disk space but may show compression artifacts if repeatedly opened, changed and saved.
- PNG: a newer compressed and lossless image format; has a 256 color and a true color variant.
- WMF, TIF

For optimal display, the image file should have the same dimensions and color depth as the display resolution used for the subject’s monitor. Although it is possible to scale the image media during presentation, this may produce unwanted raster image scaling artifacts.
All of the above image file formats are supported by common image editing software. If no conversion is available, you can copy the raster image to the Windows clipboard, then paste the image into the Windows Paint accessory. Then you can save it to a disk file from there.

**Web Media**

A typical web site consists of HTML and embedded media. The desired web site presented as stimulus needs to be displayed correctly in the installed Internet Explorer version.

**Movie Media**

Experiment Center converts (re-encodes) movies automatically to an optimized avi format. SMI is using a customized video codec XMP-4 from xVid Solutions. The following movie files can be selected before re-encoding: avi, wmv, asf, mpg, mpeg, mpe, vob, mp4, m4v, m2v. **Please ensure that you've installed a valid codec that allows to playback the original movies on the PC before you load them into** Experiment Center.

**Screen Recording Media**

All screen video material captured during experiments is saved to hard disk in the AVI file format. The screen recording of Experiment Center uses the customized xVid Solutions MPEG-4 codec (XMP-4) installed during Experiment Center setup. The XMP-4 codec is compatible to standard Xvid and DivX codecs for playback.

All screenshots taken during the stimulus presentation are saved to hard disk in the jpg file format (see above).
Appendix

Chapter IX
9 Appendix

9.1 Limitations / Setup recommendations

The performance requirements vary based on the type of stimuli, complexity of the experiment and the connected iView X eye tracking system.

Therefore not all types of experiments can be executed in a one-PC-setup, where iView X and Experiment Center are running on the same PC. For highest performance and best data quality a dual-PC-setup is recommended.

The following table is showing the dependencies and setup requirements for the available stimuli types.

System Setup conditions:

- iView X frame drops: < 1%
Screen recording performance depends on a lot criteria's (e.g. Processor, graphics board, configuration of the Operating system, used driver, performance used by the application under test) and therefore performance figures cannot be guaranteed.

There is a Microsoft limitation for avi files that exceed 1GB in file size. AVI file content can only be read until 1GB is reached. This may happen to screen recording and external video recording sessions typically longer than 30 minutes.

9.2 Dongle Installation and Troubleshooting

Experiment Center is dongle-protected. You may have to place the USB-dongle in the appropriate PC before you can start the program. If Experiment Center displays a message box stating HASP SRM Protection System: The software requires a hardware key (dongle), check the following:

1. The activity LED of the USB-dongle should show a red light if the dongle is plugged in.

2. If the activity LED does not show a red light, check the USB port status in the Windows hardware settings dialog. Open the Windows Control Panel and double click the System icon. Switch to the Hardware tab and click on the Device Manager button. Verify, that the Universal Serial Bus controllers tree does not show any yellow warning signs (⚠️). The screenshot below shows a functional USB port with a correct Windows driver installation.
If the dialog displays a warning sign (⚠️) for a driver, right click the entry and select the **Update Driver...** command from the context menu.

3. Verify that the dongle driver is installed properly. Open the Windows **Control Panel** and double click the **Add or Remove Programs** icon. Check if the list shows the **HASP SRM Run-time** entry.

Note, that the **HASP SRM Run-time** is installed during the installation of Experiment Center. Do not deny the installation of this software during installation when prompted.

Type and status of your licenses are stored on the dongle device,
not on the PC on which Experiment Center is installed. With the license update procedure, the dongle is updated. That means, that you can run Experiment Center on any PC when the dongle is plugged in.

9.3 Installation and Setup of External Video

How to adjust the external video source

Connecting an external video source is possible by using an external video grabber and an optional HDMI deciphering converter.

The SMI external video package contains of:

- Installation CD containing VGA2Ethernet Driver, Installation Guide and User Guide
- VGA2Ethernet from Ephiphan (VGA to Ethernet frame grabber), incl. power supply
  
  http://www.epiphan.com/products/frame-grabbers/vga2ethernet/

  Use only the driver distributed from SMI for the frame grabber.
- HD Fury 2 from hd fury (HDMI to VGA deciphering converter)
  
  http://www.hdfury.com/
- Ethernet cable
- Audio cable
9.3.1 Frame Grabber Driver Setup

This step has to be performed only once.

Driver Setup

1. Check if you are logged in as administrator by clicking Start \rightarrow Control Panel \rightarrow User Accounts \rightarrow Administrator.

2. Install the VGA2Ethernet Driver from your Experiment Suite 360° installation CD by clicking External Video \rightarrow Driver.

3. Configure your network connection by clicking Start \rightarrow Network Connections. Double-click on the corresponding network connection.
4. Adjust the Internet Protocol (TCP/IP) as follows:

![Internet Protocol (TCP/IP) Properties](image)
9.3.2 Hardware Setup

Hardware Setup

There are two ways the video source can be connected to the VGA2Ethernet frame grabber:
9.3.2.1 VGA Setup

Setup for devices using VGA

1. Do not connect to power yet, except for the Experiment Center PC.

2. Connect the video source (e.g. PC, MAC) with a VGA cable directly to the VGA IN port of the VGA2Ethernet frame grabber.

3. Connect the audio cable from the loudspeaker/line out port of the video source to the line-in (and not the microphone) port of the Experiment Center PC.

   Note that the line-in port is usually marked in blue on the PC.

4. Connect the Ethernet cable to the VGA2Ethernet frame grabber and to PC.
5. Check audio devices by clicking **Start → Control Panel → Sounds and Audio Devices.**

In the dialog click on the **Audio** tab. Verify the default devices and change them if needed.
By clicking **Volume...** of **Sound playback**, the following dialog appears:

Select **Options → Properties** and pick the device **Line Volume**. Then close the dialog and set the used device to **Mute**.
Alternatively you can regulate the Sound Recording as needed by clicking Volume.

6. Connect the VGA2Ethernet frame grabber to power and switch it on.
7. On the monitor of your video source PC (virtual monitor), please open the Display Properties and select the Settings tab. As you can see, the Experiment Center PC appears as second monitor. Set the resolution according to the recommended settings below.

<table>
<thead>
<tr>
<th>Connection</th>
<th>Device</th>
<th>Mode</th>
<th>Resolution (in pixel)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI</td>
<td>Game console</td>
<td>lot of interaction, lot of content changes (e.g. racing)</td>
<td>max. 576p (720x576)</td>
</tr>
<tr>
<td>VGA</td>
<td>PC</td>
<td>lot of interaction, lot of content changes (e.g. racing games)</td>
<td>max. 800x600</td>
</tr>
<tr>
<td>VGA</td>
<td>PC</td>
<td>medium interaction, medium content changes (e.g. strategy games)</td>
<td>max. 1280x1024</td>
</tr>
<tr>
<td>VGA</td>
<td>PC, MAC</td>
<td>normal user interaction with applications</td>
<td>max. 1680x1024</td>
</tr>
</tbody>
</table>

* higher resolutions result in lower sampling frequency and higher latency between original video and "grabbed" video

8. Please check if the screen refresh rate corresponds to the recommended value of 60 Hz by clicking Display Properties → Settings → Advanced → Monitor tab → screen refresh rate.

9. For best performance, set the virtual monitor into clone mode.

For further information on how to select the clone mode please refer to your graphic card.

Software Setup

1. Run the application VGA2Ethernet DirectShow config by clicking Start → Epiphan VGA2Ethernet → Epiphan VGA2Ethernet DirectShow config.

2. In the application, click on Search. The device is found and displayed. This may take a while (up to a minute).

If no device is found, please ensure that all cables and devices are correctly connected or press Refresh.
3. Please press Web config....

Your internet browser will try to open an application. Close the browser and start the application IE-Repair by clicking Start → All programs → SMI → Experiment Suite 360° → Tools → IE-Repair. In the following dialog, please press Yes, even though it is not recommended.

Please press Web config... again.

An internet browser application opens where you need to log in.

The username is: admin

The password field is left empty.
4. Please set the **Interval between VGA signal autoadjustments** to 0 seconds and press **Save and Apply VGA2USB Adjustments**.
5. Please start the application **IE-Repair** again by clicking **Start → All programs → SMI → Experiment Suite 360° → Tools → IE-Repair.** Now, enable the settings.

6. Please press **Advanced...**
Select the DirectShow tab and check the limit frame rate as follows (35fps):
7. Close both the browser and the VGA2Ethernet application.

8. Run the application VGA2Ethernet GUI. Start → Epiphan VGA2Ethernet → Epiphan VGA2Ethernet GUI.

   This is a sample program that
   - locates the capture device and
   - configures the device.
9. Adjust the video source, select **Capture menu → Configure Device**.
Please make sure the settings are set manually.

For any further information please see the additional VGA2Ethernet User Guide (pages 67 and 118) on your installation CD.

10. Click on the **VGA modes** tab. Select the selected resolution of your video source under **Standard VGA Mode**.

   Select the mode with the **Refresh Rate** that corresponds to your monitor or rather comes as close as possible, e.g. 60.317 Hz. Uncheck all other modes.
11. Close the applications. The system is now ready to use.

Please see chapter [External Video Source Element](#).
9.3.2.2 HDMI Setup

**Setup for devices using HDMI**

1. Do not connect to power yet, except for the Experiment Center PC.
2. Connect the video source (e.g. Playstation) with a HDMI cable to the HD Fury 2.
3. Connect the HD Fury 2 to the VGA IN port of the VGA2Ethernet frame grabber.

4. Connect the audio cable from HD Fury 2 to the line-in (and not the microphone) port of the Experiment Center PC.

   ![Note](image)

   **Note that the line in port is usually marked in blue on the PC.**

5. Connect the Ethernet cable to the VGA2Ethernet frame grabber and to the PC.
6. Check audio devices by clicking **Start → Control Panel → Sounds and Audio Devices**.

In the dialog click on the **Audio** tab. Verify the default devices and change them if needed.
By clicking **Volume...** of **Sound playback**, the following dialog appears:

Select **Options → Properties** and pick the device **Line Volume**. Then close the dialog and set the used device to **Mute**.
Alternatively you can regulate the **Sound Recording** as needed by clicking **Volume**...

7. Connect the VGA2Ethernet frame grabber to power and switch on the devices.

**Software Setup**
1. Run the application VGA2Ethernet DirectShow config by clicking Start → Epiphan VGA2Ethernet → Epiphan VGA2Ethernet DirectShow config.

2. In the application, click on Search. The device is found and displayed. This may take a while (up to a minute).

   If no device is found, please ensure that all cables and devices are correctly connected or press Refresh.

3. Please press Web config....

Your internet browser will try to open an application. Close the browser and start the application IE-Repair by clicking Start → All programs → SMI → Experiment Suite 360° → Tools → IE-Repair. In the following dialog, please press Yes, even though it is not recommended.
Please press **Web config...** again.

An internet browser application opens where you need to log in.

The username is: admin

The password field is left empty.
4. Please set the Interval between VGA signal autoadjustments to 0 seconds and press Save and Apply VGA2USB Adjustments.
5. Please start the application IE-Repair again by clicking Start → All programs → SMI → Experiment Suite 360° → Tools → IE-Repair. Now, enable the settings.

6. Please press Advanced....
Select the **DirectShow** tab and check the limit frame rate as follows (35fps):
7. Close both the browser and the VGA2Ethernet application.

8. Run the application VGA2Ethernet GUI. Start → Epiphan VGA2Ethernet → Epiphan VGA2Ethernet GUI.

   This is a sample program that
   - locates the capture device and
   - configures the device.
9. Set the resolution of your video source according to the recommended settings below:

<table>
<thead>
<tr>
<th>Recommended Setups</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection</strong></td>
</tr>
<tr>
<td>HDMI</td>
</tr>
<tr>
<td>VGA</td>
</tr>
<tr>
<td>VGA</td>
</tr>
<tr>
<td>VGA</td>
</tr>
</tbody>
</table>

*higher resolutions result in lower sampling frequency and higher latency between original video and "grabbed" video*
10. Now, select the **Capture menu → Configure Device** and click on the **VGA modes** tab. Uncheck all **Standard VGA modes**. Then, select **Add new mode** and enter the following data:

![Configure VGA Modes](image)

Click **Apply**.

11. If the captured device of the video source needs to be adjusted to the screen, switch to the **Adjustments** tab and configure the settings.
Please make sure the settings are set manually.

For any further information please see the additional VGA2Ethernet User Guide (pages 67 and 118) on your installation CD.

12. Close all open applications. The system is now ready to use.

Please see chapter External Video Source Element.

Each brand named in this manual is industrial property of its manufacturer.
9.4 Information on Calibration

Calibration is the process where the iView X system establishes the relationship between the position of the eye in the camera view and a gaze point in space, the so-called point of regard (POR). The calibration also establishes the plane in space where eye movements are rendered. Since this relationship strongly depends on the overall system setup and also varies between subjects, a reference measurement called calibration must be performed before each experimental trial.

During calibration, the subject is presented with a number of targets in known locations. These targets must be fixated by the subject and the position of the eye is noted by the system. Using these reference points, the system creates a mapping function that relates all eye positions to points in the calibration area (monitor).

The accuracy of gaze data is directly related to the success of the calibration.

Validation deviation calculation

1. Validation Point \( v_p \) is shown for at least 2000ms. The procedure continues with the next point after having a stable fixation for min. 400ms.

2. The mean position \( \bar{g} \) of the gaze data that was recorded during the fixation period is calculated.

3. Calculate the distance \( d_{px} = g - v_p \) between mean gaze position and validation point.

4. Calculate the angular deviation \( \varepsilon = \tan^{-1} \frac{d_{px} \cdot p_s}{h_s} \) using the distance between head and stimulus \( h_s \) and the pixel size \( p_s \).

5. All calculations are done for x and y separately.

6. Experiment Center calculates the average angular deviation for all validation points.
For more information on calibration, please refer to the iView X Online Help.

9.5 Information on User camera and Audio Recording

The observation package license is needed to record user video and user audio.

SMI delivers a selected and verified Webcam with the observation package to ensure best results (video resolution, dropped frames, delay).

The recording of a video and audio can be switched on and off in the Global Settings dialog.

There are two modes available:

- Video recording only
- Video recording and audio recording

Although the delivered webcam is "hand-selected" and no delay could be observed with this camera, a 100% synchronized recording of the user video to the presented stimuli cannot be guaranteed. The recording delay is influenced by the experiment performance requirements, the webcam driver, the USB chipset, the number of used devices on the USB interfaces and the Microsoft DirectShow interface which are all under control of the MS Windows XP/Vista operating system and can only be influenced up to a certain level.
9.6 Program Installation

The product installation media (CD-Rom) offers suitable software packages to install. Please run the auto-start application from the installation medium and click on the respective buttons to install necessary software.

The Experiment Suite 360° includes the Experiment Center as well as the BeGaze 2.4 software. To install the Experiment Suite 360°, proceed as follows:

1. Insert the installation media (CD-Rom).
   The auto-start application opens.
2. Click on the **Install from CD** button.
   Follow the steps of the installation wizard.
While installing the Experiment Suite 360°, the USB dongle driver (HASP SRM Run-time) is installed or updated. You may need to update the USB dongle license information. Refer to the BeGaze 2.4 manual under “Dongle Protection and License Update” for details.

The Microsoft .NET Framework, the Microsoft Internet Explorer, and the Microsoft Media Player software components are available from the Experiment Center installation media. These software components are also available from the Microsoft web site where you can download them for installation to the desired PC workstation. Both software components will inspect your PC workstation during installation and may issue warning messages if the PC resources do not meet the necessary performance.

Please use always the latest versions that are available for download from the Microsoft web site.

9.7 System Requirements

You can install and run Experiment Center on a standard PC workstation running the Microsoft Windows operating system if the following requirements are met:

- Experiment Center is based on the Microsoft .NET Framework Version 3.5 Service Pack 1 or above. This in turn requires the Microsoft Windows XP with Service Pack 2, Microsoft Windows Vista or Microsoft Windows 7 operating system.

Experiment Center is not compatible with Windows Vista Home Premium.
• The PC and Windows OS must be compatible with European or American keyboard and language settings. Asian language settings (e.g. Chinese) are not supported.

• The PC workstation performance should be sufficient to display or play the different media types presented during Experiment Center execution. To do so, you need adequate CPU performance combined with enough RAM and hard disk space as well as a 3D accelerated graphics adapter. This should be true for any notebook or desktop computer bought since 2007. At minimum, you need a 2 GHz Core-Duo Processor, 2 Gb of RAM and at least 10 Gb of free hard disk space. You also need a monitor together with a true color display adapter with a minimum resolution of 1280x1024 pixels to do meaningful experiments.

• You also need the Microsoft Media Player 11 or above and the Microsoft DirectX 9 multimedia runtime or above installed. You may verify the media performance by test playing a DVD film or something similar.

• If you run Experiment Center on the same PC workstation as the iView X gaze tracking system, keep in mind that during an experiment the CPU will need spare resources to examine and calculate the incoming gaze tracking data. In case you want to do experiments with different monitors for subject and operator, you also need a display adapter capable of driving a secondary display such as a notebook computer with an additional display jack.

• If you run Experiment Center on a separate PC workstation, you need at least a 100 Mbit Ethernet interface adapter to connect with the PC workstation running the iView X gaze tracking system.

Note that iView X version 2.4.33 or higher is required to run Experiment Center. If you try to connect to an incompatible version of iView X, Experiment Center displays a corresponding message box and terminates. You need to update your iView X software in this case.

Compliant and non-compliant graphic cards for Experiment Center and BeGaze
The following list contains the tested graphic card models that are compliant (recommended = yes) and non compliant (recommended=no) with Experiment Center and BeGaze.

(This list is not intended to be complete)

<table>
<thead>
<tr>
<th>Recommended</th>
<th>Vendor</th>
<th>Model</th>
<th>Memory (MB)</th>
<th>Shared Memory</th>
<th>OpenGL Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 7600 GS</td>
<td>256</td>
<td>No</td>
<td>2,1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 8500 GT</td>
<td>512</td>
<td>No</td>
<td>2,1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9600 GT</td>
<td>512</td>
<td>No</td>
<td>3,0</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 6200</td>
<td>128</td>
<td></td>
<td>2,1</td>
</tr>
<tr>
<td>yes</td>
<td>Intel</td>
<td>GMA 3100</td>
<td>384</td>
<td>Yes</td>
<td>1,4</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9800 GT</td>
<td>512</td>
<td>No</td>
<td>3,1</td>
</tr>
<tr>
<td>yes</td>
<td>Winfast</td>
<td>GeForce 8800 GTS</td>
<td>320</td>
<td>No</td>
<td>2,1</td>
</tr>
<tr>
<td>yes</td>
<td>ATI</td>
<td>Radeon X1050</td>
<td>256</td>
<td></td>
<td>2,1</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 8600 GT</td>
<td>256</td>
<td>no</td>
<td>3,2</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9500 GT</td>
<td>512</td>
<td>no</td>
<td>3</td>
</tr>
<tr>
<td>yes</td>
<td>NVIDIA</td>
<td>GeForce 9400</td>
<td>512</td>
<td>no</td>
<td>3,2</td>
</tr>
<tr>
<td>yes</td>
<td>ATI</td>
<td>Mobility Radeon 9000 IGP</td>
<td>128</td>
<td>1,3</td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 5200 FX</td>
<td>128</td>
<td>No</td>
<td>2,1</td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 8800 GTS</td>
<td>320</td>
<td>No</td>
<td>2,1</td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>FireGL V 3400</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>GeForce 8400</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX1700</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX570</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>NVIDIA</td>
<td>Quadro FX5500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>Matrox</td>
<td>Orion</td>
<td>32 MB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>ATI</td>
<td>FireGL V 3100</td>
<td>128 MB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>no</td>
<td>Matrox</td>
<td>G550 DH</td>
<td>32 MB</td>
<td>no</td>
<td></td>
</tr>
</tbody>
</table>
9.8 Network Sharing Solver Tool

This tool may help, if you're using a two PC setup and if you've failed to configure the PCs, so that the iView X PC has write access to the Experiment Center result folder. Other use is not recommended.

This program adjusts the security policy of the stimulus PC to ensure that iView X can copy eye tracking data to the shared experiments result folder in a two PC setup. To start the Network Sharing Solver, please select Start → Program Files → SMI → Experiment Suite 360° → Tools → Network Sharing Solver.

⚠️ You're changing the security policy of the computer. Please contact your system administrator before running the software.

This program performs to the following changes to the security policy made by pressing „Enable Guest Account“:

- It activates the guest user account.
- It modifies the security settings such that
  - Users don’t have to authenticate for network access and will automatically be granted “guest user” rights.
  - Accounts with no password are granted the same rights as accounts with passwords.
  - All accounts are able to access to the network on the PC.
  - Sharing Permissions of the enabled folder are replaced by Full Control of the folder Everyone.
Performing these changes may lead to unauthorized access to the computer if the LAN is not protected by a firewall and if the computer is directly connected to the internet.

Verify the computers network settings

To verify that the computer is not directly connected to the internet, you need to check whether your PC only contains private IP addresses. Open a command window in Windows and enter the command `ipconfig`. Private IP addresses may be:
- 10.0.0.0 to 10.255.255.255
- 172.16.0.0 to 172.31.255.255
- 192.168.0.0 to 192.168.255.255

If you’re not directly connected to the internet please ensure that the router forwards no requests of the internet via NAT or similar technologies on your PC. Routers are typically set to not forward requests of the internet.

Furthermore you need to assure that only trustworthy users use your local network. Every user of this network is potentially able to obtain access and partly the control of your PC.

Before use, please make sure that no sensitive data is located on your PC.

Pressing „Disable Guest Account“ reverts the above changes and disables the guest account. Existing accounts that were not able to access to the network before using this program are now allowed to access to the network.
9.9 Troubleshooting

This chapter explains some warnings and error messages that might occur and describes what the user should do in these cases.

Video Playback

If you experience problems during video playback, examine the Media Player's Help: Troubleshooting menu command as well as the Media Player's Tools: Options: Performance dialog tab. You may also run the DirectX diagnosis tool to verify the PC's capabilities. From the Windows Start menu, select the Run command, type in "dxdiag", then confirm with OK.

System Performance

Certain background processes and services require substantial system resources during execution. While this does not affect the system during idle times, those background processes may disturb a running gaze tracking experiment. If you notice a degradation in system responsiveness, you may consider the following points:

- Disable the background scan function of your virus scanner. This function scans newly started executables and various file formats while they are read in from the hard disk drive. Use the on-demand virus scan function instead.

- Make sure that no CPU consuming screen saver is automatically activated during a running experiment. It is best to completely switch off the screen saver during an experiment.

- You may also deactivate any auto-update functions. While background downloading of files does not normally use too much system resources, confirmation dialogs and update notices may disturb an experiment.

- Also check the power configuration of a notebook PC. In the Windows Control Panel, select the Performance and Maintenance category. Start the Power Options applet and select the "Presentation" entry in the Power Schemes list.
Please verify that your system setup as well as the experiment setup is matching our recommendations (see also: System Requirements).

**Experiment Center does not start**

It is not sufficient, to simply copy the Experiment Center program directory to another PC. Please use the Experiment Center installer. This ensures for example that required Microsoft .NET Framework Version 3.5 (SP1) or above is installed properly. Note that you cannot start Experiment Center from a network share / network drive because of .NET security restrictions.

**Dongle protection**

Experiment Center and BeGaze 2.4 are both dongle-protected and share the same dongle. If both programs run on different PCs, you may have to place the USB-dongle in the appropriate PC before you can start the program.

If Experiment Center displays a message box stating **HASP SRM Protection System: The software requires a hardware key (dongle)**, check the following:

1. The activity LED of the USB-dongle should show a red light if the dongle is plugged in.

2. If the activity LED does not show a red light, check the USB port status in the Windows hardware settings dialog. Open the Windows Control Panel and double click the System icon. Switch to the Hardware tab and click on the Device Manager button. Verify, that the Universal Serial Bus controllers tree does not show any yellow warning signs (!). The screen shot below shows a functional USB port with a correct Windows driver installation.
If the dialog displays a warning sign (❗) for a driver, right click the entry and select the **Update Driver...** command from the context menu.

3. Verify, that the dongle driver is installed properly. Open the Windows **Control Panel** and double click the **Add or Remove Programs** icon. Check if the list shows the **HASP SRM Run-time** entry.

Note that the **HASP SRM Run-time** is installed during the installation of Experiment Center. Do not deny the installation of this software during installation when prompted.
9.10 Turn off Hardware acceleration

It might be that you want to turn off Hardware Acceleration to improve video quality or to allow screen recording of applications that are running in the graphics memory (e.g. MS Media player).

Turning off the hardware acceleration system wide in Windows XP

You can turn off hardware acceleration completely or turn it down system wide in the following manner:

1. Click on Start -> Control Panel.
2. In the classic view, double click on the Display icon.
3. Select the Settings tab and click on the Advanced button. The Advanced Settings dialog box appears.

4. Windows Settings Tab Click on the Troubleshoot tab.
5. You can disable the hardware acceleration completely by dragging the slider to the extreme left of the scale. You can also choose to turn down the hardware acceleration by selecting an intermediate value.
Copyright and Trademarks
10 Copyright and Trademarks

Copyright

The SOFTWARE is owned by SensoMotoric Instruments GmbH or its suppliers and is protected by the Federal Republic of Germany copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g. book or musical recording) except that you may either

a) make one copy of the SOFTWARE solely for backup or archival purposes or

b) transfer the software to a single hard disk provided you keep the original solely for backup or archival purposes.

You may not copy the written materials accompanying the SOFTWARE.

The user is not entitled to allow a third party to use the software simultaneously without written approval of SensoMotoric Instruments GmbH. Independent branch offices or subsidiary companies are also understood to be a third party in this sense. SensoMotoric Instruments GmbH and/or its supplying firm remain the owners of the delivered software, even if it is altered.

Trademarks

BeGaze is a trademark of SensoMotoric Instruments GmbH.
iView X is a trademark of SensoMotoric Instruments GmbH.
Experiment Center is a trademark of SensoMotoric Instruments GmbH.
SensoMotoric Instruments is a trademark of SensoMotoric Instruments GmbH.

Microsoft, Windows are registered trademarks of Microsoft Corporation.
Chapter XI

License Agreement and Warranty
11 License Agreement and Warranty

IMPORTANT – PLEASE READ CAREFULLY: This license agreement ("Agreement") is an agreement between you (either an individual or a company, "Licensee") and SensoMotoric Instruments GmbH ("SMI"). The "Licensed Materials" provided to Licensee subject to this Agreement include the software programs, which were installed on the equipment Licensee purchased from SMI (the "Designated Equipment") at the time of delivery of the Designated Equipment and/or other software programs SMI has granted Licensee access to (the "Software") as well as any "on-line" or electronic documentation associated with the Software, or any portion thereof (the "Documentation"), as well as any updates or upgrades to the Software and Documentation, if any, or any portion thereof, provided to Licensee at SMI’s sole discretion.

By installing, downloading, copying or otherwise using the Licensed Materials, you agree to abide by the following provisions. This Agreement is displayed for you to read prior to using the Licensed Materials.

If you do not agree with these provisions, do not download, install or use the Licensed Materials. If you have already paid for the Licensed Materials, you may return them for a full refund to: SensoMotoric Instruments, Warthestraße 21, 14513 Teltow, Germany. If the Licensed Materials were installed on Designated Equipment, you may also return such Designated Equipment for a full refund.

1. **License.** Subject to the terms of this Agreement, SMI hereby grants and Licensee accepts a non-transferable, non-exclusive, non-assignable license without the right to sublicense to use the Licensed Materials only (i) for Licensee’s business operations, (ii) on the Designated Equipment, if any, or on a back-up equipment while the Designated Equipment is inoperable, and (iii) in accordance with the Documentation. Licensee may make one copy of the Software in machine readable form for backup purposes only; every notice on the
original will be replicated on the copy. Installation of the Software, if any, is Licensee’s sole responsibility.

2. **Rights in Licensed Materials.** Title to and ownership in the Licensed Materials and all proprietary rights with respect to the Licensed Materials and all copies and portions thereof, remain exclusively with SMI. The Agreement does not constitute a sale of the Licensed Materials or any portion or copy of it. Title to and ownership in Licensee’s application software that makes calls to but does not contain all or any portion of the Software remains with Licensee, but such application software may not be licensed or otherwise transferred to third parties without SMI’s prior written consent.

3. **Confidentiality.** Licensed Materials are proprietary to SMI and constitute SMI trade secrets. Licensee shall maintain Licensed Materials in confidence and prevent their disclosure using at least the same degree of care it uses for its own trade secrets, but in no event less than a reasonable degree of care. Licensee shall not disclose Licensed Materials or any part thereof to anyone for any purpose, other than to its employees and sub-contractors for the purpose of exercising the rights expressly granted under this Agreement, provided they have in writing agreed to confidentiality obligations at least equivalent to the obligations stated herein.

4. **No Reverse Engineering.** License shall not, and shall not allow any third party to, decompile, disassemble or otherwise reverse engineer or by any means whatsoever attempt to reconstruct or discover any source code or underlying ideas, algorithms, file formats or programming or interoperability interfaces of the Software or of any files contained or generated using the Software. The obligations under this Section shall survive any termination of the Agreement. Licensee may apply to SMI at the address above for further information on the interface between the Software and other applications; SMI will on reasonable terms and conditions provide such information as the Licensee may reasonably require to enable the Software to interoperate with its applications.

5. **Warranty.**
   a) If Licensed Materials show a defect during the limitation period
specified in Sec. 5 d), which already existed at the time of transfer of risk, SMI will provide Licensee with a corrected version of such defective Licensed Material (“Repeat Performance”).

b) Licensed Materials are defective, if they do not conform to the written agreement between SMI and Licensee, if any, or to SMI’s specification.

c) Licensee’s claims for defects are excluded:

- for insignificant divergences from the agreement or specification;
- for damages caused after the transfer of risk by external influences such as fire, water, currency surge, etc.; improper installation, operation, use or maintenance; use in fields of application and environmental conditions other than those expressly specified by SMI; and use in combination with other products not approved by SMI for this purpose, excessive stress or normal wear and tear;
- for defects of the Software, which cannot be reproduced;
- for Licensee’s or a third party’s modifications of Licensed Materials and results therefrom;
- in as far as Licensee has not notified SMI of apparent defects within 5 business days of delivery and of hidden defects within 5 business days of discovery.

d) The limitation period for warranty claims is 12 months. This does not apply in cases of fraud, intent, gross negligence and personal injury. Repeat performance does not restart the limitation period.

e) Licensee has to always first provide SMI the opportunity for Repeat Performance within a reasonable period of time. Repeat Performance does not constitute acceptance of a legal obligation.

f) If the Repeat Performance fails even within an additional period of time of reasonable length to be granted by Licensee, Licensee shall, notwithstanding its claims under Section 6, if any, be entitled to rescind the contract or to claim a price reduction.

g) If the analysis of an alleged defect shows that it is not covered by the above warranty, SMI may charge for the failure analysis and correction of the defect, if any, at SMI’s then applicable rates.


a) SMI is only liable for damages caused by slight negligence if such are due to a material breach of duty, which endangers the achievement of the objective of the Agreement, or the failure to
comply with duties, the very discharge of which is an essential prerequisite for the proper performance of the Agreement.

b) In cases of Section 6 a), the liability is limited to the damage, which is typical for contracts like this Agreement and which could have been foreseen.

c) SMI’s liability is also limited to the damage, which is typical for contracts like this Agreement and which could have been foreseen for damages caused by the gross negligence of an agent or an employee of SMI, who is not an officer or executive of SMI.

d) In cases of Sections 6 a) and c), SMI’s liability is limited to a maximum amount of EURO 500.000, respectively EURO 100.000 for financial losses.

e) Licensee’s claims for damages caused by slight negligence or caused by the gross negligence of an agent or an employee of SMI, who is not an officer or executive of SMI, which are not based on defects and thus not subject to time-barring in accordance with Sec. 5 d) are time-barred at the latest 2 years from the point in time Licensee became aware of the damage and regardless of Licensee’s awareness at the latest 3 years after the damaging event.

f) With the exception of liability under the Product Liability Law, for defects after having given a guarantee, for fraudulently concealed defects and for personal injury, the above limitations of liability shall apply to all claims, irrespective of their legal basis, in particular to all claims based on breach of contract or tort.

g) The above limitations of liability also apply in case of Licensee’s claims for damages against SMI’s employees or agents.

7. **SMI Indemnity.** SMI will defend or settle any action brought against Licensee to the extent based on a claim that Licensed Materials, used within the scope of the license granted in this Agreement, infringe any copyright valid in the European Union or the European Economic Area and will pay the cost of any final settlement or judgment attributable to such claim, provided (i) Licensee has given prompt notice to SMI of such claim, (ii) Licensee has not recognized an infringement of the third party’s copyright, and (iii) the entire defense and the settlement negotiations are reserved for SMI with Licensee’s full cooperation and support. If Licensee discontinues the use of Licensed Materials for damage reduction or other important reasons, Licensee is obligated to point out to the third party that the
discontinuation of use does not constitute an acknowledgement of a copyright infringement. If SMI believes Licensed Materials are likely to be the subject of an infringement claim, it may elect to replace or modify such Software or Documentation to make it non-infringing or terminate the Agreement on written notice to Licensee. SMI shall have no obligation to defend (or any other liability) to the extent any claim involves a Software release other than the current, unaltered release, if such would have avoided infringement, or use of the Software in combination with non-SMI programs or data, unless the infringement would also incur without such combination. The foregoing states the entire obligation and liability of SMI with respect to any infringement by Licensed Materials of any intellectual property rights or other proprietary rights of Licensee or a third party without prejudice to any claims for damages in accordance with Section 6.

8. **Licensee Indemnity.** Licensee will defend and indemnify SMI, and hold it harmless from all costs, including attorney’s fees, arising from any claim that may be made against SMI by any third party as a result of Licensee’s use of Licensed Materials, excluding claims for which SMI is obligated to defend or indemnify Licensee under Section 7.

9. **Export Restriction.** Licensee will not remove or export from Germany or from the country Licensed Materials were originally shipped to by SMI or re-export from anywhere any part of the Licensed Materials or any direct product of the Software except in compliance with all applicable export laws and regulations, including without limitation, those of the U.S. Department of Commerce.

10. **Non-Waiver; Severability; Non-Assignment.** The delay or failure of either party to exercise any right provided in this Agreement shall not be deemed a waiver. If any provision of this Agreement is held invalid, all others shall remain in force. Licensee may not, in whole or in part, assign or otherwise transfer this Agreement or any of its rights or obligations hereunder.

11. **Termination.** This Agreement may be terminated without any fee reduction (i) by Licensee without cause on 30 days notice; (ii) by SMI, in addition to other remedies, if Licensee fails to cure any breach of its obligations hereunder within 30 days of notice thereof; (iii) on notice by either party if the other party ceases to do business in the
normal course, becomes insolvent, or becomes subject to any bankruptcy, insolvency, or equivalent proceedings. Upon termination by either party for any reason, Licensee shall at SMI’s instructions immediately destroy or return the Licensed Materials and all copies thereof to SMI and delete the Software and all copies thereof from the Designated Equipment.

12. **Entire Agreement; Written Form Requirement.** There are no separate oral agreements; any supplementary agreements or modifications hereto must be made in writing. This also applies to any waiver of this requirement of written form.

13. **Notices.** All notices under the Agreement must be in writing and shall be delivered by hand or by overnight courier to the addresses of the parties set forth above.

14. **Applicable Law and Jurisdiction.** German law applies with the exception of its conflict of laws rules. The application of the United Nations Convention on Contracts for the International Sale of Goods (CISG) is expressly excluded. The courts of Berlin, Germany, shall have exclusive jurisdiction for any action brought under or in connection with this Agreement.

Teltow, Germany, 2004- 2010
SensoMotoric Instruments GmbH
Chapter XII

About SMI
12 About SMI

SensoMotoric Instruments® (SMI) was founded in 1991 by a group of research scientists, physicians, and engineers in order to pursue the commercial development of measurement and evaluation systems in the field of medicine, psychology, ergonomics, human factors, and virtual reality. SMI specializes in development and system integration in the field of video and sensor technology, associated with digital image and signal processing. In 1992, SMI was awarded the Innovation Prize of Berlin-Brandenburg for VOG - Video-Oculography, its video-based eye movement technology.

This technology has found widespread use in the medical diagnosis and research of eye movement, psychology research as well as in specific research applications, for example on the space station MIR. For further development SMI collaborates with leading clinical and research laboratories and partners around the world.

Please contact us:

SensoMotoric Instruments GmbH (SMI)
Warthestraße 21
D-14513 Teltow
Germany
Phone: +49 3328 3955 0
Fax: +49 3328 3955 99
email: info@smi.de

SensoMotoric Instruments, Inc.
75 Arlington Street
Boston, MA 02116
USA
Phone: +1 (857) 241 3865
Fax: +1 (857) 241 3601
Toll-Free: 888 SMI USA1
email: info@smiusa.com

Please also visit our homepage: http://www.smivision.com

Copyright © 2010 SensoMotoric Instruments GmbH

Last updated: February 2010
Index

- A -
About SMI 177
Analysis
  BeGaze 2.4 97
  Subject Protocol 96
Application Window 99

- B -
Basic Operation 15
BeGaze 2.4 97

- C -
Calibration 90
  Background Information 154, 155
  Setting 45
  Tips 92
  Verification Picture 90
Commands 104
Connection Settings 19, 22
Copyright 168, 170
CSV 96

- D -
Data Paths 19, 113
Data Storage Structure 112, 115, 116
  Experiment 115
  Results 116
Delete 39
Directory Structure 113
Dongle

- E -
Experiment 113, 115
  Analyzing Measurement Data 97
  Basic Operation 15
  Calibration 90
  Change 35
  Delete 39
  Directory Structure 113
  Dry Run 84
  End 95
  Execution 93
  File 115
  Load 35
  New 34
  Run 85
  Save 37
  Start 88
Experiments
  Import and Export 114
Export Measurement Data 97
Exporting Experiments 114

- F -
Features 12
File 115, 116
  Experiment 115
  Formats 118
File 115, 116
Results 116
Firewall Settings 22

- G -
Gaze Data 92
Global Settings 19

- H -
Hotkeys 93, 107

- I -
IDF file 116
Importing Experiments 114
Installation 156
Introduction 2
iView X 33

- K -
Keys 107

- L -
License
Agreement 170
Update 9
Load 35

- M -
Media Types 118
Menu Commands 104

- N -
Network 19, 22

- O -
Open 35
Overview 12

- P -
Point of Regard 92
Product Variants 8
Program
Installation 156
Protocol 95, 96

- R -
Randomization Groups 75
Recording
End 95
Presentation 93
Start 88
Step-by-Step 85
Remote Path 19, 22
Requirements 157
Results 116

- S -
Safety Instructions 6
Save 37
Scrambling Groups 75
Security Advice 6
Settings
Connection 19
Double Monitor 26
Network 22
Subject Properties 78
Setup 16

© 2010 SensoMotoric Instruments GmbH
<table>
<thead>
<tr>
<th>Index 180</th>
</tr>
</thead>
</table>

## Software Version
4

## Starting Experiment Center
33

## Step-by-step Instructions
32

## Stimulus
- Image 59
- Monitor 88
- Movie 65
- Random Order 75
- Reference 93
- Screen Recording 67
- Set 41
- Text 52
- Web 62

## Subject Information
88

## Subject Properties
78

## Subject Protocol
96

## Supported File Formats
118

## System
- Requirements 157
- Setup 16

## Target
92

## Text Editor Window
109

## Toolbars
101

## Verification Picture
90

## Warranty
170

## Workflow
15

## User Interface
99

## Application Window
99

## Keys
107

## Menu Commands
104

## Text Editor Window
109

---

© 2010 SensoMotoric Instruments GmbH